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This report was prepared as a result of work sponsored by the Ozone Transport
Commission (OTC). The opinions, findings, conclusions, and recommendations are

those of the author and do not necessarily represent the views of OTC. OTC, its officers,
members, employees, contractors, and subcontractors make no warranty, expressed or
implied, and assume no legd liability for the information in thisreport. OTC has not
approved or disapproved this report, nor has OTC passed upon the accuracy or adequacy
of the information contained herein.



OTC Emission Reduction Workbook: 2.1

Table of Contents

1. Introduction

2. User

s Manuad

2.1  Assessing Multi-Pollutant Regulations

2.2 Assessing Emission Performance Standards

2.3  Assessing Energy Efficiency and Clean Generation Programs
3. TheDefault Data
3.1  The Default Emission Rates

311
312
313
314
3.15
3.1.6

32

3.3

34

35

What is an Average Marginal Emission Rate?
Selecting the Right Default Emission Rate
How the Default Rates Were Developed
The Near-Term Displaced Rates (2002-2005)
The Medium- Term and Long-Term Displaced Rates (2006-2020)
More Discussion of the Default Emission Rates
Default Data on Existing Generating Units
Data on Clean Generators
Data on Future Electricity Use

Program and Technology Load Shapes

4. Strengths, Limitations and Recommended Work

Appendix

A. Additions and Retirements Assumed in PROSYM Runs

16
22
30
30
30
31
32
33
36
39

45
46
46
47
50



OTC Emission Reduction Workbook: 2.1

Figure 2.1:
Figure 2.2:
Figure 2.3:
Figure 2.4:
Figure 2.5:
Figure 2.6:
Figure 2.7:
Figure 2.8:
Figure 2.9:

Figure 2.10:
Figure 2.11:
Figure 2.12:
Figure 2.13:
Figure 2.14.
Figure 2.15:
Figure 2.16:
Figure 2.17:
Figure 2.18:

List of Figuresand Tables
Schematic of the Worksheets in the Workbook
Inputs and Results for a Multi-Pollutant Regulation
Entering the New Emission Limits
The Location of Information on Generating Units
Pasting Entire Rows of Data into the Tables on “Multi-P Calcs’ Sheet
Selecting Data on Future Electricity Use
Calculating Future Electricity Use Numbers
Entering Data on Regional Average Emission Rates
The Table for Custom Data on Average Regional Emission Rates
Inpus and Results Box for an EPS Calculation
Entering Total Energy Savings
Load Profile Data for a Residential Air Conditioner Program
Allocating Energy Savings to Time Periods
The Tables for Entering Program Emission Rates
Calculating Emissions from an Energy Efficiency Program
Selecting Default Datain for the Displaced Emission Rates
Total Emission Reductions are Calculated on Table 3

Inputs and Results Box for a Displaced Emissions Calculation

Table 3.1: Choosing the Right Displaced Emission Rates

Figure 3.1:
Figure 3.2:
Figure 3.3

The Default Displaced Emission Rates for PIM
The Default Displaced Emission Rates for New York 1SO
The Default Displaced Emission Rates for ISO New England

Table 3.2: Weighting Factors for PROSY M Rates and New/Old Plant Rates

Figure 3.4
Figure 3.5:
Figure 3.6:
Figure 3.7:
Figure 3.8:

NOy Emission Rates Along the ISO New England Supply Curve in 2002
ISO New England NOx Curves and Distribution of Loads

Comparison of PIM NOy and SO, Emission Rates

Comparison of New York NOy and SO, Emission Rates

Comparison of New England NOy and SO, Emission Rates

Table 3.3: Default Load Shapes for Energy Efficiency

4

10
11
12
13
17
18
19
19
21
23
23
24
25
26
27
28
29
32

35
36
38

41
42
42
43
47



OTC Emission Reduction Workbook: 2.1

1. Introduction

The Ozone Trangport Commission’s Emission Reduction Workbook verson 2.1
(“Workbook™) is designed to provide asmple, user-friendly means of ng the
emissons impacts of arange of different energy policies affecting the dectric industry.
The geographic focus of the Workbook is the northeastern U.S,, specificdly the three
northeastern eectricity control areas. PennsylvanialNew Jersey/Maryland (PIM), the
New York 1SO (NY 1S0) and 1SO New England (ISO NE).! Thetempord focusisan
elghteen-year period, beginning in 2002. Whileit is not a forecasting tool (designed to
predict the future), the Workbook alows users to investigate different future scenarios
eadly and to discern the range of probable outcomes and the importance of different
factorsin determining these outcomes.

The Workbook is designed to be flexible and transparent. It isflexible in that the user
can evauate arange of energy program types. Specificaly, three program types can be
evauated:
Programs that would displace generation, such as energy efficiency programs and
programs that incentivize new clean generation;

Programs that would ater the average emission rate of the eectricity usedina
gtate or region, such as an Emissions Performance Standard (EPS); and

Programs that would reduce the emission rates of specific generating units, such
as multi- pollutant regulations gpplied to existing generating units.

The Workbook is dso flexible in that users may use default assumptions contained in the
Workbook or enter information based on their own assumptions.

The Workbook is transparent in that assumptions on which a scenario is based are clearly
recorded for future reference. The Workbook contains default data from severd different
sources, and default information is clearly marked with its source? Important data
sourcesinclude:

Default displaced emission rates developed for the three northeastern control
aress using the PROSY M system dispatch modd;

Data on dectricity use from the U.S. Energy Information Adminigration (EIA);
and

Daafrom the U.S. Environmenta Protection Agency (EPA) on power plant
emissons
Thistrangparency is extremely important in making the kind of predictions that the
Workbook is designed to make, because these predictions are highly senditive to certain
assumptions. For example, predictions of emission reductions from programs that
displaced emissons are highly sengtive to assumptions about plant additions and
retirements over time. Predictions of reductions from multi- pollutant regulations are

! Theterm “1SO” refersto an Independent System Operator.

2 In the current version of the Workbook, there is one exception to thisrule. The dataon the load shapes of
energy efficiency programs are from a proprietary source.
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highly dependent on assumptions about the affected units utilization before and after the
regulation. Because of these sengtivities, it isimportant that al assumptions on which a
prediction is based are clearly stated along with the prediction. Also, because there may
be considerable uncertainty around these input assumptions, it may be prudent to assess
potentid emisson reductions usng arange of different input assumptions.

This document includes a user’s manua for the Workbook (Section 2), a discussion of
the default data stored in the Workbook (Section 3) and a summary of the strengths and
limitations of the current version of the Workbook and suggested future work to improve
it (Section 4).
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2. User's Manual

Verson 2.1 of the Workbook isaMicrosoft Excel workbook consisting of ten
spreadsheets for calculations and an “Overview” sheet.®> Each type of calculation for
which the Workbook is designed has a main spreadsheet on which most of the
caculaions are performed. These main sheets, shown in yelow in Figure 2.1, are caled
“Multi-P Calcs,” “EPS Calcs,” and “Digplacement Cacs” The“Multi-P Cacs’ sheet is
for caculating emisson reductions from multi- pollutant regulations gpplied to exigting
power plants. The“EPS Cacs’ sheet isfor assessng EPSs, and the “ Digplacement
Cacs’ sheet isfor assessing policies that promote energy efficiency and new clean
generation. Figure 2.1 below shows a schematic of the worksheets in the Workbook.

In addition to these three, main worksheets, there are seven sheets where (1) supporting
caculations are made and (2) default input data are stored. In Figure 2.1 an arrow going
from one sheet to another indicates that detais stored on the white sheet, which can be
used for caculations on the yellow sheet. The worksheets in the Workbook can be
reordered a any time by clicking on them and dragging them to the right or left. A small
black arrow will appear when a sheet is being moved to help you place it where you want
it.

Figure 2.1: Schematic of the Worksheets in the Workbook (“Overview” sheet)

—Indicates that data are drawn
from this sheet for calculations.

Generation and Use
Information on total electricity
generation in the three
Northeastern control areas is

EPS Calcs Multi-P Calcs

Calculations for EPSs occur
here. Data on electricity use
(not generation) is drawn from
the "Generation & Use" page.
Data on system average
emission rates (not marginal
displaced rates) is drawn from
the "Displaced Rates" page.

Custom Displaced Rates
Users enter their own data
for dispalced emission rates
here. This sheet is formatted
in the same way as the
Default Dispalced Rates
sheet.

\

Default Displaced Rates
Default data on displaced
emission rates for each power
control area are recorded
here. System average rates
are used for EPS calculations.

>

recorded here. Users may use the
default load growth assumption
(1.5% per year) or enter their own.
Electricity use (generation less
losses) is recorded here as well.

Inputs & Results

All key assumptions from other
pages are recorded on this page
along with results. Saving a copy
of this page records the scenario
for future reference.

[Calculations for Multi-pollutant
regulations occur here. User
can select base-case data on
lexisting units from the "Multi-P
Data" sheet and enter it here.

Program Rates

For programs that displace
generation from existing units, the
emission rate of the "program
generation” is recorded here.
Energy efficiency has zero
emissions. Some types of "clean”
generation (e.g., biomass) will
have emissions.

Program Penetration

The energy saved or clean
energy generated by the
program being assessed is
calculated here for the years
2002 through 2020.

Multi-P Data

Default data is stored here
for 176 older fossil-fired units
in the Northeast. Users
select units here for analysis
on the "Multi-P Calcs" sheet.

—

Displacement Calculations
For programs that displace generation from existing units

(energy efficiency and new clean generation), calculations of
displaced emissions takes place on this page.

Dlndicates that calculations

are made on this sheet.

Dlndicates that data are stored

or recorded on this sheet.

% There are 13 spreadsheets in the Workbook in total, however two of these sheets (“Reference” and “No
Displaced Rates”) are used only by the Workbook itself for calculations.
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There are four boxes on the “Inputs& Results’ sheet. Each of these boxes records the key
inputs and results of a caculation and contains a Space for descriptions of key
assumptions. Once you have completed a caculation, we suggest that you save or print a
copy of the corresponding box as a record of your inputs and results.

The drop-down menus in the Workbook are driven by

meacros. Because many viruses contain macros, email _ men
sarvers and software applications can be configured to Th(ar]drop (Ij:l;wnk us
disable them. If you find that the drop-down menus do In _t e Workbook are
not function properly, first check the security settingsin driven by macros.

Excd. To do this, go to the Tools menu and sdect

“Macros’ and “Security.” If the security level isset to It these us do not

“High,” set it to “Medium,” and then close Excel. Then function properly, first
reopen it and seeif the Workbook functions properly. If check the security

nat, try setting the macro security to “Low” and settingsin Excel, then
reopening again. If the Workbook till does not work, check the settings in
check the security settingsin your server and/or email your server and email
program to make sure these programs are not disabling

the macros. preglelin

The use of Microsoft Excd for this Workbook is attractive in that the software isSsmple

to use and many people are familiar with it. Excel does present limitations, however,

when used for a cdculaion tool such asthisone. The main limitation is thet, where
drop-down menus have been used, cdls cannot be locked for editing. Thus, a user could
inadvertently delete part of atable that is linked to a drop-down menu. Usersshould

only delete data they have entered using the “Clear” command in the Edit menu as
discussed below. If you think you have inadvertently deleted a portion of the Workbook,
select “Undo Typing” from the Edit menu. In addition, aways save a clean backup copy

of the Workbook to start over on if need be.

Toillustrate how the Workbook is used, the three subsections balow discuss in detail
three calculations using the Workbook.

2.1 Assessing Multi-Pollutant Regulations

Cdculaions of emisson reductions from multi- pollutant regulations are made using two
worksheets. "Multi-P Cacs' and "Multi-P Data" Key inputs and results are recorded in
Box 3 on the "Inputs& Results' worksheet. The basic procedure for these calculationsis
asfollows.
1. Predict “base-casg’ utilization of the affected units (i.e.,, without the new
regulation) and caculate base-case emissons.
2. Predict utilization of the units under the new regulation and cacuate regulated
emissons
3. Subtract regulated emissions from base-case emissonsto get total emission
reductions from the regulation.

Userswill follow this procedure to assess regulations that gpply a reduced emission rate
to agroup of generding units. Users ng aregulation that caps emissions at a
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group of units will perform only step one and then smply subtract the tons alowed under
the cap from base-case emissonsto calculate totd reductions. Below is a step-by-step
description of how to assess emission reductions from a multi- pollutant regulation.

Step 1.

Firgt you must “zero out” the tables you plan to use (i.e, The reSL_" ts of each :
remove any data |eft there from previous use). Zero out calculation, along with
al tables with red text on the “Multi-P Calcs’ sheet: key inputs, are recorded
Tables 1, 1.A, 4.A and 5.A through 5.D. To zero out in tables on the

tables, enter “0” in the upper left cell and copy it down “ Inputs& Results’ shest.
and acrossthewholetable. Y ou must also delete any

generating unit data that gppear in Tables 2 through 2.F. Print or save a copy of
To delete data, select the entire row and go to the File thistable as a record of
menu. Goto “Clear” and select “Contents.” Do not :

delete data using the * Delete” key. your calculation.

Next go to the “Inputs& Results’ sheet of the Workbook

and locate Box 3, a cdl AC3. Hereyou will enter genera information about the

program you are assessing. Typein brief information for “Policy Assessed,” * Region”
and “Number of Affected Units’ — see Figure 2.2 below. Note that the electronic verson
of the Workbook (but not in this manual) text next to these headingsisred. Throughout
the spreadshect, red text in a cell indicates that data can be entered that cell. Text that
gppearsin black is either default data or a number calculated by the Workbook. In Box 3
of the “Inputs& Results’ sheet, cells with black text are linked to other cdlsin the
Workbook, and this information will be recorded automaticaly as you enter information
elsewhere.

Note also that there is a space at the bottom of Box 3 labeled “ Notes on Key
Assumptions” Here you may enter additiond information on the assumptions that
underlie your caculation, such as base case emisson rates and unit utilization rates.
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Figure 2.2: Inputs and Results for a Multi-Pollutant Regulation (“Inputs & Results” sheet)

3. Multi-Pollutant Regulations

[Policy Assessed:  JEnter Text |
Assumotions
3.A: General Assumptions
Region: Enter Text
Number of Affected Units: 0
Base Case Emission Rates: Default

3.B: Regulated Emission Limits

Emission Limits for Emission Limits for

"Group 1" Units (Ib/MWh) "Group 2" Units (Ib/MWh :

Year: 0 0 0 Year: 0 0 0
NOx 0.0 0.0 0.0 NOXx: 0.0 0.0 0.0
S02: 0.0 0.0 0.0 S02: 0.0 0.0 0.0
CO2: 0 0 0] Cco2 0 0 0
Ho: 0.0E+00 0.0E+00 0.0E+00} Hg: 0.0E+00 0.0E+00 0.0E+00|

Results ****sers should round NOx, SO2 and mercury results to two significant figures and CO2 results to three.****

3.C: Base Case Generation (MWh)
2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018
1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

3.D: Base Case Emissions (tons)

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018
NOXx: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
S02: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Cco2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Hg: 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000
3.E: Regulated Generation (MWh)
|_2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018
| 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
3.D: Regulated Emissions (tons)
2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018
NOx: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
S02: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Co2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Hg: 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000
3.E: Total Annual Emission Reductions (tons)
2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018
NOXx: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
S02: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Co2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Hg: 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000

Notes on Key Assumptions:

Note that, although it is not shown here, these tables extend to the right through 2020.

10
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Step 2:

The caculations for a multi- pollutant regulation dl take place on the “Multi-P Calcs’

sheet. At thetop of this sheet are Tables 1 and 1.A, where users enter the new emission
limits to be applied to the affected plants. (See Figure 2.3 below.) Below these small
tables are Sx rows of large tables stacked on top of each other. Below Tables1 and 1.A
are Tables 2 through 2.F, placed side-by-sde and extending right on the spreadsheet dll
theway to Column “DT.” Base-case data on the affected units are entered in these tables.
Other tables in which deta are entered or calculations made are in Smilar rows below
these tables.

Note that in row 2 of the “Multi-P Calcs’ sheet there are yearslisted in bold. These are
the column headings for dl tables on this sheet. Throughout the Workbook, columns are
labeled once at the top of the Worksheet rather than many times at the top of each table.

To dign the column headings (years) at the top of the table
on which you are working, smply scroll down the sheet

until the row of yearsisin theright place. To align the column

headings (years) with the
Go to the “Multi-P Calcs’ sheet and enter the emission top of the table on which
rates that will be applied to the affected unitsin Table 1 or .

Tebles1 and LA. If all unitswill be subject to the same you are working, scroll
emisson limits, use Table 1 only. To assess regulations down the She_et _untl | the
that become tighter over time, enter the different limitsin row of yearsisin the
the columns of Table 1, with the trigger year in the top row. right place.

If different limitswill gpply to different groups of

generating units, enter the limitsfor one group in Table 1
and limitsfor the other group in Table LA.

As an example, we will assess NOy and SO limits applied in 2005 to the four
Danskammer unitsin New York. Asseenin Figure 2.3, the NOx limit we will asessis
1.5 Ib/MWh, and the SO, limit is 3.0 I/MWh. Note that throughout the Workbook,
emission rates are sated in units of pounds per MWh of generation.

Figure 2.3: Entering the New Emission Limits (“Multi-P Calcs” sheet)

Calculations for Analysis of Multi-Pollutant Regulations
2002 2003 2004 2005 2006 2007 2008 2009 2010 2011

1. Emission Limits for 1.A: Emission Limits for

"Group 1" Units (Ib/MWh) "Group 2" Units (Ib/MWh)

Year: 2005 Year:

NOx 1.5 0.0 0.0 NOx 0.0 0.0 0.0
S0O2 3.0 0.0 0.0] SO2 0.0 0.0 0.0
CO2 0 0 0 CO2 0 0 0
Hg 0.0E+00 0.E+00 0.E+00 Hg 0.E+00 0.E+00 0.E+00

Notes: Enter the emission rates (in Ib/MWh) to be app|

Columns for several years are provided to ass
| Base Case Data: | Default _j Several tables are provided to assess regulatic
Select Default or Custom data.

Step 3:

Indicate in the drop-down box below Table 1 whether you will be using the default
information (“ Default”) on affected units or entering your own information ("Custom™).
Y our choice will be recorded on the “Inputs& Results’ sheet. Descriptions of the default

11
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data sources and methodology are located in boxes at the bottom of each table on the

“Multi-P Data’ sheet.*
Step 4.

Next, enter base-case information on the affected generating unitsin Tables 2 through 2.F
on the"Multi-P Calcs' sheet (at row 17). You may use ether the default data stored in
the Workbook or your own data on the affected units. The default information is stored
on the "Multi-P Data' sheet. The default information islaid out on this sheet in exactly

the same format asit will be entered on the “Multi-P Cacs’ sheet. Thisformat is shown
in Figure 2.4. (On the “Multi-P Calcs’ shet, these are Tables 2 through 2.F. On the

“Multi-P Data’ sheet, these are Tables 1 through 1.F)

Figure 2.4: The Location of Information on Generating Units (“Multi-P Data” sheet)

Table Table Table Table Table
1 1.A 1.B 1.C 1.D
Unit NO rate 0, rate CO rate Hg rate

Info

Table Table
1.E 1.F
Cap. Generation

Factor

The base case capacity factors listed in Table 1.E are taken from the base case PROSYM
modeling runs performed to develop the default displaced emisson rates. This modeling

run smulates the operation of each northeastern control
area under predicted future loads and base case
assumptions about plant additions and retirements.
(This modding run and the underlying assumptions are
discussed further in Section 3.1 below.) These capacity
factors are an important input assumption to your
caculation, and they should be presented with your
results. Save or print a copy of Table 1.E for your
records.”

Full sets of default data are included for most large
steamn generating unitsin PIM, NY 1SO and ISO NE.
Partial sets of data are included for a number of
generating unitsin Pennsylvania but outside of the PIM
region. For these units, emission rates are provided but

To remove data that you
have entered in the
Workbook, do not usethe
Delete button.

Sl ect the Data and go to
the Edit menu. Select
“Clear” from this menu,
and choose “ Contents”
from the drop-down menu

that appears.

* Note that this list includes units located throughout Pennsylvania, not just units within the PJM control
area. In contrast, the modeling runs performed to devel op the default displaced emission rates only include

generating unitsin PIM.

® To save thistable electronically, select it, copy it and open anew Excel workbook. In the Edit menu of
the new workbook, select “Paste Special.” In the dialogue box that appears, select “Values,” and allow the
text pasted to remain selected. Then go to Edit and “Paste Special” again and select “Formats.” Inthe new
file, you may have to adjust the “Zoom” setting (in the View menu) and the column widths for best
viewing. To print thistable, select the table and click “Page Setup” under the File menu. In the dialogue
box that appears, select “ Portrait” and “Fit-to-One,” and then click “Print.” In the print dialogue box, click

“Selection,” and then “O.K.")

12
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base case capacity factors and generation are not provided. Thetext “no data’ appearsin
Tables 1.E and 1.F for these units. Users must develop a base case capacity factor
assumption and cal culate base case generdtion in order to assess regulaionsinvolving
these units. If theterm “#VALUE!" appearsin row 224 of the “Multi-P Calcs’ shedt,
check to make sure there are capacity factors and generation figures (in Tables 2.E and
2.F) for dl units you are assessing.

To use the default data, find the generating unit you want in Table 1 on the “Multi-P

Data’ sheet, and sdlect and copy the entire row in which that unit gppears. (To sdlect the
entire row, click on the row number a the far left of the worksheet.) Then go to the
"Multi-P Calcs' sheet and paste the entire row of datainto the first empty row in Table 2
(row 17). To pastein the entire row of data, you must either select the entire target row
or sHect thefirg (leftmost) cell in that row. By pasting the entire row, all the
information from Table 1 through 1.F on the “ Multi-P Data” sheet is placed in the
correct spot in Tables 2 though 2.F on the "Multi-P Calcs" sheet, because this section of
these two sheets is formatted exactly the same. In Figure 2.4 below, asthe highlighted
rows are pasted into the spreadsheet, data on the four Danskammer units are inserted into
Tables 2 through 2.F. (Note that Figure 2.4 only shows the leftmost portion of the
Spreadshest; data will be aso pasted into Tables 2.B through 2.F, to the right of this
figure)

Figure 2.5: Pasting Entire Rows of Data into the Tables on the “Multi-P Calcs” Sheet

1. Emission Limits for
"Group 1" Units (Ib/MWh)

Base Case Data:
Select Default or Custom data.

2. Affected Units

Default 7]

1.A: Emission Limits for
"Group 2" Units (Ib/MWh)

Year: 2005 Year:

NOx 1.5 0.0 0.0 NOx 0.0 0.0 0.0
S02 3.0 0.0 0.0 SO2 0.0 0.0 0.0
COo2 0 0 0 CO2 0 0 0
Ha 0.0E+00 _0.E+00 0.E+00 Ha 0.E+00 0.E+00 0.E+00

2.A: Base Case NOx Rates

Notes:

Enter the emission rates (in Ib/MWh) to be app
Columns for several years are provided to ass
Several tables are provided to assess regulatic

Station No. MW N Oy (Ib/Mw
Danskammer 1 64 2.0 1.9 1.9 1.9 1.9 1.9 1.9 1.9 1.9 1.9
Danskammer 2 125 2.0 1.8 1.8 1.8 1.8 1.8 1.8 1.8 1.8 1.9
Danskammer 3 127 4.0 3.0 3.0 3.0 3.0 3.0 3.0 3.0 3.0 3.0
Danskammer 4 232 4.2 3.1 3.1 3.1 3.1 3.1 3.1 3.1 3.1 3.1

After pasting in arow, check to make sure that Tables 2 through 2.F arefilled with deta
inthat row. Repedt this step for each affected unit, pasting the entire row of dataiinto the

next avallable row in Table 2.

If you are assessng a multi- pollutant regulation for a subset of the four pollutantsin the
Workbook (NOx, SO, CO, and mercury), you must erase the data you entered for
pollutants you are not assessing. Here, since we are only assessing NOy and SO,
regulations, you must clear the data pasted into Tables 2.C and 2.D. Do this by selecting
dl the data that were pasted into those tables and go to the “Edit” menu. Select “ Clear”
from this menu and then sdect “ Contents’ from the drop down menu that gppears. Do
not clear data from the worksheet by using the“ Delete” key.

13
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If you are entering your own data on affected units, type it directly into Tables 2 through
2.F onthe “Multi-P Calcs’ sheet. Make sure you enter data for each unit in dl of these
Tables, and make sure to enter emission ratesin [lb/MWh.

Asinformation for each generating unit is added in Tables 2 through 2.F on the “Multi-P
Calcs’ shest, total base-case emissonsfor the group will be summed in Tables 3 through
3.D (dtarting at row 119). For each unit, annua emissions are the product of base case
generation from Table 2.F (MWh) and the base case emission rate (Ib/MWh) divided by
2000to get tons. The sumsfor the entire group of units are shown in row 226. Annua
total emissions of al pollutants entered are summed for the years 2002 through 2020.

The emisson rates for each unit in the default data are based on datain EPA’s 2000 Acid
Rain Database. EPA cautions that some of these numbers may not reflect changes made
recently at generating units. We recommend that users check dl available documentation
of ar emissons a each generating unit they assessin order to estimate base-case
emissons most accurately. More information on the default data appearsin Section 3.2
below.

Step 5:

If you are assessing a multi- pollutant regulation that gpplies an emisson cap to the
affected units, you can now smply subtract the tons in the emission cap from the basdine
tonsto caculate total emission reductions. If you are assessing aregulation that applies
reduced emission rates to the affected units, you must now estimate emissions under the
new regulaion.

Go to Table 4 on the “Multi-P Calcs’ sheet (at row 226). Here you will enter your
prediction of unit capacity factor (utilization rate) under the multi- pollutant rule. Note
thet the list of generating units you entered in Table 2 automatically sppearsin Table 4.
Enter the predicted capacity factor for each unit in each year in Table 4.A (at cell F226).
Y our prediction of unit utilization should reflect the expected increase in each unit's
operating costs due to the regulation. Idedlly, users should use a system dispatch model
to make this prediction, however, if you cannot do this, make assumptions about
regulated capacity factors and present these assumptions with your results. If you use
this approach, we recommend that you make caculations based on severd different
assumptions about regulated utilization and assess the range of results. Print a copy of
Table 4.A with each scenario to record your assumptions for that scenario.®

As s00n as you enter a capacity factor for aunit in agiven year, the Soreadsheet will
automaticaly caculate total generation in that year in Table 4.B (at cdll Z226).

® To save thistable electronically, select it, copy it and open anew Excel workbook. In the Edit menu of
the new workbook, select “Paste Special.” In the dialogue box that appears, select “Values,” and allow the
text pasted to remain selected. Then go to Edit and “Paste Special” again and select “ Formats.” Inthe new
file, you may have to adjust the “Zoom” setting (in the View menu) and the column widths for best
viewing. To print thistable, select the table and click “Page Setup” under the File menu. In the dialogue
box that appears, select “ Portrait” and “Fit-to-One,” and then click “Print.” In the print dialogue box, click
“Selection,” and then “O.K.”
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Step 6:

Next you must caculate total emissions from the affected units under the multi- pollutant
regulation. Go to Table 5.A onthe“Multi-P Calcs’ sheet (at cell F332). Here, in each
cdl of Tables5.A through 5D, you will multiply the appropriate MWh vaue from Table
4.B by the appropriate emission limit you entered in Table 1 (or Tables 1 and 1.A) and
divide by 2000 to convert from poundsto tons. Theformulain thefirst cdl of Table 5.A
(cell F334) would be: “=2228*$C$6/2000.” Thefirg term is the predicted generation in
2002 (based on your assumed capacity factor), and the second term is the emission limit
(1.5 Ib/MWNh) you entered in Table 1. Y ou must add the dollar Sgnsin front of the terms
“C” and “6” to lock the reference on this cdll, alowing you to drag the formulainto other

cdls’

Now sdect the formulain cell F334 and copy it across the row al the way to rightmost
column of Table5.A. Thiswill caculate NOy emissonsin every year for the first
generating unit in your list. If you are evauating multiple generating units, you can now
select the entire row of formulas you have entered for the first unit onthelist and drag
that row down through dl other rows. In our example, evauating the four Danskammer

units, we would drag the formulas down four rows.

Y ou must st up the formulasin thisway in as many tables (5.A through 5.D —
corresponding to NOy, SO,, CO, and mercury emissions) as pollutants you are ng.
In this example, you only need to do it in Tables 5.A and 5.B. Theformulasin each year
for each generating unit will be the same across dl tables (pollutants) except for the
second term. The second term will change with each pollutant, targeting the gppropriate
emisson limitin Table 1. Remember to use the dollar sign to lock the cell reference to

the appropriate cdll in Table 1, so you can copy the formula
and pagteit into other cdls.

Asyou cdculate emissons under the new emisson limitsin
Tables5.A through 5.D, the spreadsheet will automaticaly
caculate total emisson reductions from the regulation, in
Tables 6.A through 6.D. The numbersin Tables 6 through
6.D will aso appear in Box 3 on the "Inputs & Results'
sheet, a cell AC3. Figure 2.2 above showsBox 3. You
should round caculations of NOy, SO, and mercury
emissons to two sgnificant figures and caculations of CO;
reductions to three. These are the number of sgnificant

There are two
significant figuresin
the default NO,, SO,
and mercury emission
rates and three in the
default CO, rates.

Be sure to round your
results appropriately.

" When you drag aformulain MS Excel, the cell references move as you drag the formula, preserving the
relative locations of the cellsin the formula. Placing adollar signin front of aterm in the formulalocks the

reference to that cell. For example, if you typedin acell “=D5*X?2" and dragged the formulaone cell to
theright, the formulain the new cell would be“=E5*Y2.” If you dragged the formula one cell down, the
new formulawould be “=D6* X3.” However, if you typed “=$D$5* X2" and dragged it one cell to the
right, the new formulawould be “=$D$5*Y2.” If you dragged it one cell down, the new formulawould be
“=$D$5* X3.” Consult an Excel manual for more information on writing and dragging formulas.
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figuresin the default emission ratesin the Workbook.2 1n most calculations, the
Workbook will present results with far too many sgnificant figures. In Box 3 thereis
aso aspace for notes. 'Y ou should describe the assumptions you made regarding
regulated utilization of the affected units and other key inputs. Save Box 3 to another
Excel workbook or print it as arecord of your caculation.®

2.2 Assessing Emission Performance Standards

Cdculaions of emisson reductions from EPSs are made using four worksheets. The
main calculations are made on the "EPS' sheet. Default data are stored and custom data
are entered on the "Electricity Use" "Default Displaced Rates' and “Custom Displaced
Rates’ sheets. Inputs and results are recorded in Box 4 on the"Inputs & Results’
workshest.

The generd gpproach to caculating emission reductions from EPSsis as follows.

1. Predict future annua dectricity use.

2. Cdculatetota emissonsin a“base-casg’” scenario (multiply eectricity
use in each region by regiond average emisson rates).

3. Cdculaetotd emissonswith the EPS (multiply dectricity usein each
region by the EPS emisson limits).

4. Subtract total annua EPS emissions from tota base case emissonsin
each region to get annua emisson reductions from the EPS.

Bdow are detalled ingructions for performing this caculation with the Workbook.
Step 1.

Firgt, zero out Table 1 on the “Program Rates’ sheet. To do this, enter “0” in the upper
left cell and copy it down and across the whole table. Next, go to the“EPS’ sheet and
select “No Data’ in the drop-down menusin Boxes 1, 2 and 3. Thiswill ensure that you
are arting with clean workspaces.

Now go to the “Inputs& Results” sheet and enter information about the program you will
assess. GotoBox 4, a cel BD3. Box 4 isshown in Figure 2.10, below. Enter short,
descriptive information in the spaced provided to describe the “Policy Assessed,”
“Region” and “Annud Load Growth.” For “Annud Load Growth,” indicate your
assumption for annua dectricity load growth in the states you are assessing. If you use

8 Of course, if you have used your own data for calculations, adifferent number of significant figures may
be appropriate.

® To save thistable electronically, select it, copy it and open anew Excel workbook. In the Edit menu of
the new workbook, select “ Paste Special.” In the dialogue box that appears, select “Values,” and allow the
text pasted to remain selected. Then go to Edit and “Paste Special” again and select “ Formats.” Inthe new
file, you may haveto adjust the “Zoom” setting (in the View menu) and the column widths for best
viewing. To print thistable, select the table and click “Page Setup” under the File menu. In the dialogue
box that appears, select “ Portrait” and “Fit-to-One,” and then click “Print.” 1nthe print dialogue box, click
“Selection,” and then “O.K.”
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the default data in the Workbook on eectricity use, load growth is 1.5 percent per year.
In the workbook (but not in this manud) the text in the cdlls next to these wordsiis red.
Throughout the Workbook, red text indicates that you should enter information there. All
of the cellswith black text in Box 4 are linked to other cellsin the Workbook.

Next, proceed to the “EPS,” sheet. The“EPS’ sheet consists of five boxes stacked
vertically down the spreadsheet. There are no workspaces to the right of these boxes. In
Boxes 1 through 3, users enter data and calculate emissions for the PIM, New York ISO
and ISO New England areas, respectively. In Box 4, total emission reductions acrossdl
three regions are summed. In Box 5, users enter data on eectricity use in each region.

Step 2:

Scroll down to Table 5 at the bottom of the "EPS' sheet (at cdl B120). Thisiswhereyou
will enter your prediction of future eectricity usein your region of interest. If you plan

to use the default data on future eectricity use, sdlect "Default Datd' in the drop-down
menu in cdl 1120, and the default data will gppear in the Table. Table 5 and the drop-
down menu are shown in Figure 2.6 below. (The columnsin Figure 2.6 are years,
beginning with 2002. The years are labeled in the second row of the worksheset. To dign
the years at the top of the table, smply scroll down the worksheet until the yearsarein

the right place)

Figure 2.6: Selecting Data on Future Electricity Use (“EPS” sheet)

5. Annual Electricity Use (MWhs) | Data Source: | Default Data R
New England
CT 30,857,000 31,320,000 31,790,000 32,267,000 32,751,000 33,242,000 33,740,000 34,247,000 34,760,000
MA 50,339,000 51,094,000 51,861,000 52,639,000 53,428,000 54,229,000 55,043,000 55,869,000 56,707,000
ME 6,599,000 6,698,000 6,799,000 6,901,000 7,004,000 7,109,000 7,216,000 7,324,000 7,434,000
NH 10,278,000 10,432,000 10,589,000 10,748,000 10,909,000 11,072,000 11,239,000 11,407,000 11,578,000
RI 7,335,000 7,445,000 7,557,000 7,670,000 7,785,000 7,902,000 8,021,000 8,141,000 8,263,000
VT 5,809,000 5,896,000 5,985,000 6,074,000 6,166,000 6,258,000 6,352,000 6,447,000 6,544,000
New York 128,271,000 130,195,000 132,148,000 134,130,000 136,142,000 138,184,000 140,257,000 142,361,000 144,496,000
PJM
MD 62,452,000 63,389,000 64,340,000 65,305,000 66,284,000 67,279,000 68,288,000 69,312,000 70,352,000
NJ 64,718,000 65,689,000 66,674,000 67,674,000 68,689,000 69,720,000 70,766,000 71,827,000 72,904,000
PA 101,108,000 102,625,000 104,164,000 105,727,000 107,312,000 108,922,000 110,556,000 112,214,000 113,898,000
Other
DE 11,098,000 11,265,000 11,434,000 11,605,000 11,779,000 11,956,000 12,135,000 12,317,000 12,502,000
DC 10,937,000 11,101,000 11,268,000 11,437,000 11,608,000 11,782,000 11,959,000 12,138,000 12,321,000
Totals

New England 111,217,000 112,885,000 114,579,000 116,297,000 118,042,000 119,812,000 121,610,000 123,434,000 125,285,000
New York 128,271,000 130,195,000 132,148,000 134,130,000 136,142,000 138,184,000 140,257,000 142,361,000 144,496,000
PJM 228,278,000 231,702,000 235,178,000 238,705,000 242,286,000 245,920,000 249,609,000 253,353,000 257,154,000

Other 22,035,000 22,366,000 22,701,000 23,042,000 23,387,000 23,738,000 24,094,000 24,456,000 24,822,000

OTC Total 489,801,000 497,148,000 504,605,000 512,174,000 519,857,000 527,655,000 535,570,000 543,603,000 551,757,000

The default dectricity use data are based on 2000 data from the U.S. Energy Information
Adminigration (EIA) on eectricity use by state. We have increased EIA’s 2000 numbers
by 1.5 percent per year to derive the 2002 numbers, and future year estimates are
cdculated usng the same annud growth factor.

If you would like to base your calculations on other assumptions about future dectricity
use, select "Custom Data' on the drop-down menu above Table 5. Then go to Table 2
on the "Electricity Use" sheet (cell B34) and cdculate your data. Thistable is formaited
50 that you only need to (1) enter data for 2002 in the first column and (2) enter an annua
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load growth percentage in the box provided above the table (in cell H34). From these
inputs, the table will caculate eectricity usein dl future years. Figure 2.7 shows the
table on the “Electricity Use” sheet for caculating custom data on electricity use.

Figure 2.7: Calculating Future Electricity Use Numbers (“Electricity Use” sheet)

2: Custom Data (MWhs) | Annual Load Growth: | 1.200% |

New England
CT 30,857,000 31,227,284 31,602,011 31,981,236 32,365,010 32,753,390 33,146,431 33,544,188
MA 50,339,000 50,943,068 51,554,385 52,173,037 52,799,114 53,432,703 54,073,896 54,722,782
ME 6,599,000 6,678,188 6,758,326 6,839,426 6,921,499 7,004,557 7,088,612 7,173,675
NH 10,278,000 10,401,336 10,526,152 10,652,466 10,780,295 10,909,659 11,040,575 11,173,062
RI 7,335,000 7,423,020 7,512,096 7,602,241 7,693,468 7,785,790 7,879,219 7,973,770
VT 5,809,000 5,878,708 5,949,252 6,020,644 6,092,891 6,166,006 6,239,998 6,314,878

New York 128,271,000 129,810,252 131,367,975 132,944,391 134,539,723 136,154,200 137,788,050 139,441,507

PIM
MD 62,452,000 63,201,424 63,959,841 64,727,359 65,504,087 66,290,137 67,085,618 67,890,646
NJ 64,718,000 65,494,616 66,280,551 67,075,918 67,880,829 68,695,399 69,519,744 70,353,981
PA 101,108,000 102,321,296 103,549,152 104,791,741 106,049,242 107,321,833 108,609,695 109,913,012
Other
DE 11,098,000 11,231,176 11,365,950 11,502,342 11,640,370 11,780,054 11,921,415 12,064,472
DC 10,937,000 11,068,244 11,201,063 11,335,476 11,471,501 11,609,159 11,748,469 11,889,451
Totals

New England 111,217,000 112,551,604 113,902,223 115,269,050 116,652,279 118,052,106 119,468,731 120,902,356
New York 128,271,000 129,810,252 131,367,975 132,944,391 134,539,723 136,154,200 137,788,050 139,441,507
PJM 228,278,000 231,017,336 233,789,544 236,595,019 239,434,159 242,307,369 245,215,057 248,157,638

Other 22,035,000 22,299,420 22,567,013 22,837,817 23,111,871 23,389,213 23,669,884 23,953,923

OTC Total 489,801,000 495,678,612 501,626,755 507,646,276 513,738,032 519,902,888 526,141,723 532,455,423

If you have caculated custom data on dectricity use, return now to the “EPS’ shest.
Step 3:

GotoBox 1 (titled “PIM”) at the top of the "EPS’ page. From here, we will describe
how to calculate emission reductions for and EPS implemented only in the PIM region.

If you will be assessng EPSsin other regions, follow the directions below, usng Box 2
on the“EPS’ sheet for New York and Box 3 for New England. All three boxes|ook the
same and work in the same way. The Workbook will sum emission reductions across all
regions for which you enter data.

In Box 1 a the top of the "EPS' page, annual energy use appearsin Table LA, from the
datayou just entered in Table 5. Now enter your assumption about PIM system average
emisson ratesin Table 1.B by sdlecting default or custom data in the drop-down menu
abovethetable If you sdect "Default Data," the default datawill automaticaly appear

in Table 1.B, as shown in Figure 2.8.
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Figure 2.8: Entering Data on Regional Average Emission Rates (“EPS” sheet)

Emission Performance Standards
2002 2003 2004 2005 2006 2007 2008 2009 2010
1. PIM
1.A: PJM Electricity Use
MWhs: 228,278,000 231,702,000 235,178,000 238.705.000 242.286.000 245,920.000 249.609.000 253,353,000 257,154.000
1.B: Average PJM Emission Rates (Ib/MWh) | Data Source: | Default Data ;|
NOx: 2.8 2.5 2.3 1.7 1.7 1.7 1.7 1.7 1.7
SO2: 6.5 6.1 53 4.8 4.6 4.5 4.1 3.6 3.3
Co2: 1,521 1,451 1,366 1,318 1,294 1,286 1,269 1,242 1,244
Hg: 8.0E-05 7.9E-05 7.7E-05 7.4E-05 7.3E-05 7.3E-05 7.3E-05 7.3E-05 7.4E-05

If you would like to use other data on system average emission rates, sdlect "Custom

Daad' in the drop-down menu above Table 1.B.
Step 4.

If are using default data on system average emission rates, skip to Step 5. If you are
entering your own data on system average rates, select “ Custom Data’ in the drop-down
menu above Table 1.B onthe “EPS’ sheet and then go to the "Custom Displaced Rates'
sheet. Enter system average emission rates for PIM, for each year 2002-2020, in Table

1.E, asshown in Figure 2.9, below.

Figure 2.9: The Table for Custom Data on Average Regional Emission Rates (“Custom

Displaced Rates” sheet)

1.D: PJM Non-Ozone Season Night/Weekend (Ib/MWh)
NOXx: 0 0 0 0 0 0 0 0 0 0 0
SO2: 0 0 0 0 0 0 0 0 0 0 0
CO2: 0 0 0 0 0 0 0 0 0 0 0
Hq: 0 0 0 0 0 0 0 0 0 0 0
1.E: PJIM Annual Average (Ib/MWh)
NOXx: 0 0 0 0 0 0 0 0 0 0 0
SO2: 0 0 0 0 0 0 0 0 0 0 0
CO2: 0 0 0 0 0 0 0 0 0 0 0
Hg: 0 0 0 0 0 0 0 0 0 0 0
1.F: PJM Peak Day (Ib/MWh)
| NOXx: 0 0 0 0 0 0 0 0 0 0 0
Make sure you enter emission ratesin Ib/MWh and enter
rates for al pollutants and years. After you have entered If you are not

datain Table 1.E of the “ Custom Displaced Rates' sheet,
your datawill appear in Table 1.B onthe “EPS’ sheet. (If
it does not appear, make sure you have selected “ Custom
Data’ in the drop-down menu above Table 1.B on the
“EPS’ sheet.)

After you select default data or enter your own datain
Table 1.B, the soreadshect will automatically caculate total
base-case emissonsfor PIM in Table 1.C of the "EPS'
sheet. Inthiscaculation, the spreadsheet will add seven
percent to regiona eectricity use to account for line losses.
Thisis necessary because the eectricity use figures are for
energy use at the end use Site, not ectricity generation.
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On average, seven percent of al dectricity generated in the Northeast islogt in
transmission to end users. Thus, we increase energy use figures by seven percent to
gpproximate total generation.

Findly, if you are not assessing an EPS in PIM, select “No Data’ from the drop-down
menu. Thisisimportant. The Workbook will ultimately sum results from dl three
control aress. If dataare |€eft in tables for regions you are not ng, the datawill be
included in your cdculaion.

Step 5:

Next, enter the EPS emission limits you wish to apply in each region. Enter these rates
for PIM in Table 1.D onthe"EPS" sheet. (For New Y ork and New England, use Tables
2.D and 3.D onthissheet.) The EPSrate istherate that adl retall dectricity suppliers
must meet, on aweighted average. Enter the EPS rate for each pollutant for each year
2002-2020. Make sureto enter ratesin Ib/MWh. To modd adeclining EPS, smply
make the EPS rate decline over the period at any rate you wish.

Step 6:

If you are assessing an EPS across multiple regions, you will now need to go back and
enter the same data for the other region(s). Follow steps 2 through 5 above, except use
the Tablesin Box 2 on the “EPS’ sheet for New Y ork and thosein Box 3 for New
England.

Caution! Make sure that you have selected “ No Data” for the regional average
emission rate (in the drop down menus above Tables 1.B, 2.B and 3.B on the “ EPS’
sheet) for any region you are not assessing. You should see zeroes throughout the table.
If you leave numbersin thistable they will affect your results. Also make sure no data on
EPS emission rates appear in Tables 1.D, 2.D and 3.D for regions you are not assessing.

Once you have entered the EPS emission rates, the “EPS’ spreadsheet automatically
cdculaes four sets of numbers:

Tota emisson reductions in each region (in Tables

1.F 2.Fand 3.F), ad

Totd emission reductions across al three regions
(in Box 4, cell B111).

There are two
significant figuresin
the default NO,, SO,
Regiona and total annua reductionswill aso appear in and mercury emission
Box 4 on the "Inputs& Results' sheet, aong with key input rates and threein the
assumptions for thiscaculation. A portion of Box 4 is default CO, rates.
shown in Figure 2.10. Note that you must round your 2
results to two sgnificant figures a some point before you Be sure to round your
present them, because the default emisson ratesin the .
Workbook only contain two sgnificant figures. In most results appropriately.
cdculaions, the Workbook will present results with far too
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many significant figures. Thereis dso a space in Box 4 for notes on other important
input assumptions. Save a copy of Box 4 as arecord of your calculation. ™

Figure 2.10: Inputs and Results Box for an EPS Calculation (“Inputs & Results” sheet)

|POI\c¥ Assessed JEnter Text |

Assumbtions
Notes on Key Assumptions:

4.A: General Assumptions

[Region: Enter Text
Annual Electricity Use Data: Default Data
Annual Load Growth (PJM): Enter Percent
Displaced Emission Rates (PIM) No Data
Displaced Emission Rates (NY ISO): No Data
Displaced Emission Rates (ISO NE): No Data

4.B: Energy Use (MWhs)
2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016
PJM| 228,278,000 231,702,000 235,178,000 238,705,000 242,286,000 245,920,000 249,609,000 253,353,000 257,154,000 261,011,000 264,926,000 268,900,000 272,933,000 277.027.000 281,183,000

NY 1SO| 128,271,000 130,195.000 132,148,000 134,130,000 136,142,000 138,184,000 140,257,000 142,361,000 144,496,000 146,664,000 148,864,000 151,097,000 153,363,000 155,664,000 157,999,000

ISO NEI 111,217,000 112,885,000 114.579.000 116.297.000 118.042.000 119.812,000 121.610.000 123.434,000 125.285.000 127.165.000 129.072.000 131.008.000 132.973.000 134.968.000 136,992,000

Tmal| 467,766,000 474,782,000 481,905,000 489,132,000 496,470,000 503,916,000 511,476,000 519,148,000 526,935,000 534,840,000 542,862,000 551,005,000 559,269,000 567,659,000 576,174,000

4.C: PJM EPS Emission Rates (Ib/MWh)

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016
NOx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
S02: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Co2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Hg: 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00

4.D: NY ISO EPS Emission Rates (Ib/MWh)

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016
NOx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
S02: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Co2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Hg: 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00

4.E:_1SO NE EPS Emission Rates (Ib/MWh)

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016
NOXx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
S02: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
coz: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Ha: 0.0E+00 0.0E+00 0.0E+00___0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00
Results ***Users should round NOx, SO2 and mercury results to two significant figures and CO2 results to three.***
4.F: PIM Emission Reductions (tons)
2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016
NOx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
so2: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
co2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Hg: 0.0E+00 0.0E+00 0.0E+00___0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00

4.G: NY ISO Emission Reductions (tons)

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016
NOx 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
sO2: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
co2. 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Hg: 0.0E+00 0.0E+00 0.0E+00 _ 0.0E+00 0.0E+00 0.0E+00 _ 0.0E+00 0.0E+00 0.0E+00 0.0E+00 _ 0.0E+00 0.0E+00 0.0E+00 _ 0.0E+00 0.0E+00
4.H: 1ISO NE Emission Reductions (tons)
2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016
NOx 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
so2: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Cco2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Ha: 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00

4.1: Total Emission Reductions (tons)

Note that, although it is not shown here, these tables extend to the right through 2020.

10 To savethis table electronically, select it, copy it and open anew Excel workbook. In the Edit menu of
the new workbook, select “Paste Special.” In the dialogue box that appears, select “Values,” and allow the
text pasted to remain selected. Then go to Edit and “ Paste Special” again and select “Formats.” Inthe new
file, you may have to adjust the “Zoom” setting (in the View menu) and the column widths for best
viewing. To print thistable, select the table and click “Page Setup” under the File menu. Inthe dialogue
box that appears, select “ Portrait” and “Fit-to-One,” and then click “Print.” In the print dialogue box, click
“Selection,” and then “O.K.”
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2.3 Assessing Energy Efficiency and Clean Generation
Programs

Cdculations of reductions from energy efficiency and clean generation use four
goreadsheets. The main calculations are made on the “Displacement Calcs’ sheet. Data
are pulled from the “Program Pen.” shedt, the “ Program Rates’ sheet and ether the
“Default Displaced Rates’ sheet or the “ Custom Displaced Rates’ sheet.

The generd gpproach to these caculations is as follows.

Characterize energy saved or clean energy generated in future years on the
“Program Pen.” shest.

Enter the emission rates of the energy saved or clean energy generated
(energy efficiency has an emission rate of zero).
Enter data on the emission rate of the dectricity displaced by the energy

efficiency or clean generation (default data are provided and users may
enter their own assumptions).

Below, we demonstrate how these calculations are made, using as an example a
resdentid air conditioner subsidy in the PIM region.

Step 1.

First, you must zero out Table 1 on the “Program Pen” sheet and Table 1 on the “Program
Rates’ sheet, removing any numbers |eft there from previous work. To do this, enter “0”
in the upper left cell and copy it down and acrossthe wholetable. Next, go to the
“Digplacement Calcs’ sheet and select “No Data’ in the drop-down menusin Boxes 1, 2,
4,5, 7and 8. Thiswill ensure that you are starting with clean workspaces.

Next, go to the “Inputs& Results’ sheet and locate Box 1 at cell B3. Key inputs and
results of your calculation will be recorded herein Box 1 and Box 2 (directly under Box

1, a cell B41). Box 1 records key inputs, and Box 2 records key results. These boxes are
shown in Figure 2.18 below. Enter genera information about the program you are
as=ssing in the four cdls with red text in them.  In this example, you might enter
“Regdential Air Conditioners’ as the program assessed and “PIM” astheregion. Inthe
gpaces for “Displaced Emission Rates’ and “Load Profile Data,” indicate whether you

will be using the default data in the Workbook or your own data.

Step 2.

Now you will enter information on the energy saved or clean energy generated by the
program you are assessing. Go to the “Program Pen” sheet. Y ou will need to know the
total annua MWhs reduced (or generated) by the program in each year of program
operation. Enter the total MWhs saved in each year in the row called “PIM Total” (row
13 on the “Program Pen” sheet), as shown in Figure 2.11 below. For this example, we
will smply enter 1,000 MWhs for each year, 2002 through 2012. (Note that the numbers
in cell D13 are red, indicating that data should be entered there.) Default data provided in
the Workbook will help you to estimate MWhs saved in each period of the year using the
tota annual savings numbers you just entered.
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Figure 2.11: Entering Total Energy Savings (“Program Pen” sheet)

Program Penetration

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011

1: Program Penetration

1.A: PIM MWhs Generated/Saved

Ozone Season Weekday 0 0 0 0 0 0 0 0 0 0
Ozone Season Night/Weekend 0 0 0 0 0 0 0 0 0 0
Non-Ozone Season Weekday 0 0 0 0 0 0 0 0 0 0
Non-Ozone Night/Weekend 0 0 0 0 0 0 0 0 0 0
Peak Day 0 0 0 0 0 0 0 0 0 0
Peak Hours 0 0 0 0 0 0 0 0 0 0
|PJM Total [ 1,000 0 0 0 0 0 0 0 0 0

Step 3.

Next you will dlocate total energy savings in each year to the five time periods of the
year, listed in Table 1.A. You can do this using default data provided in the Workbook,

or your own assumptions about the performance of the
program. Note that Table 1.A includes six time periods
into with which you can describe the operation of your
program. The first four time periods should be used
together to describe programs that operate across a
number of seasons or different daily time periods. The
fina two should used separately, to describe programs
that only operate during hours with very high loads.
Thus, if you are assessing, for example, aload
management program — which would only operate when
loads reached extreme levels— you should place dll
energy savingsin either the “Peak Day” or the “Peak
Hours’ category. If you are ng a program that will
operate at times other than (or in addition to) peak

Thefirst four time
periods should be used
together, to describe
programs that operate
across a number of
seasons or daily time
periods. Each of the final
two should be used by
itself, to characterize all
the output of a program.

periods, you should alocate program savings across the first four periods. We will
dlocate savings from the resdentia air conditioner program across thefirdt four time
periods. We will do this using default data stored in the Workbook.

The default data on program load profile are stored in Box 2, directly under Box 1 on the
“Program Pen” sheet. Scroll downto Table 2.F at cell C69. Thistable, shown in Figure
2.12, includes percentages designed to allocate the savings of aresidentid air conditioner
program to different times of the year. There areload profilesin Box 2 for 18 different

programs that users might want to assess.

Figure 2.12: Load Profile Data for Residential Air Conditioner Program (“Program Pen”)

2.F: Residential Air Conditioner
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65%
35%

65%
35%

65%
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Ozone Season Night/Weekend 35%

65%
35%

65%
35%

65%
35%

65%
35%

65%
35%

65%
35%
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Non-Ozone Night/Weekend
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0%

0%
0%

0%
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0%
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0%
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0%
0%

0%
0%

0%
0%
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Y ou can use the datain Table 2.F to dlocate program energy by multiplying the total
annud energy savings figures you have entered in Table 1.A by the percentagesin Table
2F. Gotothefirg cdl in Table 1A (itiscel D6, for the Ozone Season Weekday in
2002). Inthiscdl, multiply tota annua MWhs saved in 2002 (cell D13 in the “ PIM
Total” row of Table 1.A) by the percentage of savings expected during this periodin
Table 2.F. Theformulawill be“=D$13*D70.” Copy thisformuladown Table 1.A,
filling in dl 9x rows showing time periods in them. (Be careful not to drag thisformula
into the “PIM Totd” row.) Then copy the formula across dl the columns of Table 1.A,
through year 2020. Thiswill fill in Table 1.A, as shown in Figure 2.13. Y ou should get
650 MWhs for each year in the ozone season weekday period, 350 MWhs in the ozone
season night/weekend period and no savingsin any other period.

Figure 2.13: Allocating Energy Savings to Time Periods (“Program Pen” sheet)

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013
1: Program Penetration
1.A: PIM MWhs Generated/Saved
Ozone Season Weekday 650 650 650 650 650 650 650 650 650 650 650 0
Ozone Season Night/Weekend 350 350 350 350 350 350 350 350 350 350 350 0
Non-Ozone Season Weekday 0 0 0 0 0 0 0 0 0 0 0 0
Non-Ozone Night/Weekend 0 0 0 0 0 0 0 0 0 0 0 0
Peak Day o o o o O 0O O O 0 0 0 O
Peak Hours 0 0 0 0 0 0 0 0 0 0 0 0
|PJM Total | 1,000 1,000 1,000 1,000 1,000 1,000 1,000 1,000 1,000 1,000 1,000 0
If we were assessing a program implemented in more than one region, we would now
enter tota energy savingsin Tables 1.B and/or 1.C and alocate it to time periods.
Caution! Make sure that numbers are not left in Box 1 of the “ Program Pen” sheet for
any control areas that you are not assessing. In this example, focused on PJM, Tables
1.B and 1.C (for New York and New England) should be filled with zeroes. Non-zero
numbersin any of these tables will affect the final results.
Step 4.
_ s onsfrom th Make sure that
Now you must estimate air emissions from the program you numbers are not left in
are asessing. Because we are assessing an energy efficiency Box 1 of th
program in this example, emissons will be zero for all . OX 2 O the .,
pollutants. However, if we were assessing a subsidy for Program Pen” sheet
clean generation, we would have to estimate emissons from for any control areas
this generation. To do this, you would go to the “Program that you are not
Rates’ sheet, and enter the estimated emission rates in Table assessing.
1. To hdp users estimate emissions, the Workbook incudes
default emission rates for clean generation and spaces for All numbersin this
caculations. Box will affect the
For example, assume you are ng a Renewable results.

Portfolio Standard (RPS). The user will have to etimate the
weighted average emissons of each pollutant from the energy generated by the RPS.

24



OTC Emission Reduction Workbook: 2.1

Y ou could do this by ether (1) usng the default emission ratesin Table 2 on the
“Program Rates’ shedt, or (2) by entering your own assumptions about emissions from
different types of renewable generatorsin Table 3 — see Figure 2.14 below. Nextin
Table 4, you would enter your assumption about how much of the RPS energy would
come from each technology. Findly, in eech cell of Table 1, you would multiply the
appropriate emisson rate (from Table 2 or 3) by the gppropriate weighting factor (from
Table 4) for each technology expected to play arolein the RPS.H

Figure 2.14: The Tables for Entering Program Emission Rates (“Program Rates” sheet)

Program Emission Rates

1. Emission Rates of Clean Generation (Ib/MWh)

2002 | 2003 | 2004 | 2005 | 2006 | 2007 | 2008 | 2009 | 2010 | 2011 | 2012 |
NOx: 0 0 0 0 0 0 0 0 0 0 0
SO2: 0 0 0 0 0 0 0 0 0 0 0
Cco2: 0 0 0 0 0 0 0 0 0 0 0
Ha: 0 0 0 0 0 0 0 0 0 0 0
2: Default Clean Energy Emission Rates (Ib/MWh) 3: Custom Clean Energy Emission Raj
Plant Type NOXx S02 Cc0o2 Hag Plant Type | NOX |
Wwind 0 0 0 0] Wind 0
Hvdro 0 0 0 0 Hydro 0
Photovoltaic 0 0 0 0 Photovoltaic 0
Biomass (existing) 1.5 0.3 0 0 Biomass (existing) 0
Landfill Gas 0 0 0 0 Biomass (RPS) 0
Microturbine 0.5 0 1,425 0 Landfill Gas 0
Fuel Cel 0.03 0 1.050 0 Microturbine 0
Fuel Cell 0
Notes: See text box below.
4. Percentage of Energy Generated from Each Technology
Plant Tvpe | 2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012

wind 0 0 0 0 0 0 0 0 0 0 0
Hvdro 0 0 0 0 0 0 0 0 0 0 0
Photovoltaic 0 0 0 0 0 0 0 0 0 0 0
Biomass (existing) 0 0 0 0 0 0 0 0 0 0 0

Step 5.

Now you will direct the spreadsheet to calculate tota emissons from the energy

efficiency program. Go to the “ Digplacement Cacs’ sheet. On this sheet there are nine
boxes — three for each control area. Boxes 1 through 3 pertain to PIM; boxes 4 through 6
pertain to the NY 1SO; and Boxes 7 through 9 pertain to ISO NE. In each Box there are
sx tables, corresponding with the same six time periods in Box 1 of the “ Program Pen”
sheet. Go to Box 1 on the “Displacement Calcs’ sheet. Thisiswhere you will caculate
the emissions from the program being assessed. The drop-down menu at the top of Table
1 dlowsyou to sdlect ether “Energy Efficiency” or “Clean Generation.” When you

sdect “Energy Efficiency,” the Tables within Box 1 arefilled with zeroes, because there

1 For example, if the user expected the RPS energy to be half wind energy and half landfill gas, the

formulain thefirst cell of Table 1 would be “(E16* E30)+(E21* E35),” where E30 and E35 are both 50%.
If the user were entering their own emission rates, the formulawould be “ (016* E30)+(021* E35).”
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are no emissions from saved energy. See Figure 2.15. If you sdlect “Clean Generation”
in the drop-down menu, the MWh figuresin Table 1.A of the “Program Pen.” sheet will
be multiplied by the emission rates for clean generation that you calculated on the
“Program Rates’ sheet.

Figure 2.15: Calculating Emissions from an Energy Efficiency Program (“Displacement
Calcs” sheet)

Displacement Calculations

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012
1: PJM Program Emissions

| Program Assessed: | Enerav Efficiency ;I
1.A: Ozone Season Weekday (tons)
NOXx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
S02: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
CO2: 0 0 0 0 0 0 0 0 0 0 0

Hg: 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00

1.B: Ozone Season Night/Weekend (tons)

NOXx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
SO2: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
CO2: 0 0 0 0 0 0 0 0 0 0 0

Hg: 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00

1.C: Non-Ozone Season Weekday (tons)

NOx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
SO2: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Step 6.

Now you will enter information about the emissions “ displaced” by the air conditioner
program in PIM. These are the emission rates representative of the generating units
projected to operate less because of the energy efficiency program. First, you must
decide whether to use the default data for displaced emission rates or your own
assumptions. The Workbook provides default displaced rates based on modeling of these
three regions with the PROSY M dispatch modding software. (For additiona

information about the development of the default displaced emission rates, see Section 3
below.) The default displaced rates are stored on the “Default Displaced Rates’ shest.
The default rates for PIM arein Table 1, and the rates for New Y ork and New England
arein Tables 2 and 3, respectively.

To sdlect the default rates or enter your own data, go to Box 2 on the * Displacement
Cdcs’ shedt. Itisdirectly to theright of Box 1, a cell Y4. Noticethat thereisadrop-
down menu in Table 2 (at cell AH6) smilar tothe onein Table 1. If you would liketo
use the default displaced rates, select “Default Datd’ from this menu, and the Workbook
will automeatically multiply the gppropriate energy savings figure on the “Program Pen”
sheet by the appropriate default emisson rate. The results of this multiplication will
appear in Table 2 on the “Displacement Cacs’ sheet, under the drop-down menu.
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Figure 2.16: Selecting Default Data for the Displaced Emission Rates (“Displacement
Calcs” sheet)

2: PJM Displaced Emissions

|  Displaced Rates: || Default Data ;I
2.A: Ozone Season Weekday (tons)
NOx: 0.7 0.7 0.7 0.6 0.6 0.5 0.4 0.3 0.3 0.2 0.2 0.2
S0O2: 1.0 1.0 1.0 1.1 0.8 0.9 0.8 0.7 0.6 0.2 0.2 0.2

If you are using your own data rather than the default data, sdlect “Custom Data’ from
this menu and go to the “ Custom Displaced Rates’ sheet. There are three Boxes on the
“Custom Displaced Rates’ sheet. Box 1 isfor PIM, and Boxes 2 and 3 are for New York
and New England, respectively. Enter your data on displaced system emisson ratesin
the appropriate Box. In this example, you would enter custom data on displaced
emissonsin PIM in each of thefird four time periodsin Box 1 — the same time periods
that ended up with energy savingsinthein Table 1.A of the “Program Pen” sheet. Make
sure to enter emission rates in Il/MWh, and make sure to enter emisson rates for all
years. If you have sdlected “Custom Data’ in the menu on the “ Displacement Cacs’
sheet, the Workbook will automatically calculate displaced emissions (in tons) as you
enter emission rates into the “ Custom Displaced Rates’ sheet.

Step 7.

Asthe “Displacement Calcs’ sheet cdculates program emissons (in Box 1) and
displaced emissions (in Box 2), it dso caculates total emisson reductionsin Box 3 (at
cdl AV4). In Tables 3.A through 3.D, totd emission reductions are caculated for each
of the four time periods. Figure 2.17 shows Box 3 on the “ Displacement Calcs’ shet.
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Figure 2.17: Total Emission Reductions are Calculated on Table 3 (“Displacement
Calcs” sheet)

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019
3: PIJM Emission Reductions

3.A. Ozone Season Weekday (tons)

NOx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
S02: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Co2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Hg: 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00

3.B: Ozone Season Night/Weekend (tons)

NOXx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
so2: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
co2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Ha: 0.0E+00__0.0E+00__0.0E+00__0.0E+00 __0.0E+00 _0.0E+00 _0.0E+00__0.0E+00__0.0E+00 _0.0E+00 _0.0E+00__0.0E+00__0.0E+00 _0.0E+00 _0.0E+00__0.0E+00__0.0E+00 _0.0E+00

3.C: Non-Ozone Season Weekday (tons)

NOx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
S02: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Co2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Hg: 0.0E+00__0.0E+00__0.0E+00_ _0.0E+00 _0.0E+00 _0.0E+00 0.0E+00 _0.0E+00__0.0E+00 0.0E+00 0.0E+00 0.0E+00 _0.0E+00 _0.0E+00 0.0E+00__0.0E+00 _0.0E+00 _0.0E+00

3.D: Non-Ozone Season Night/Weekend (tons)

NOx 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
s02 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Cco2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Hg: 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00

3.E:_Peak Day (tons)

NOXx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
S02: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Co2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Hg: 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00 0.0E+00

3.F: Peak Hours (tons)

NOx: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
S02: 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0
Co2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Hg: 0.0E+00__0.0E+00__0.0E+00_ _0.0E+00 _0.0E+00 _0.0E+00 0.0E+00 _0.0E+00__0.0E+00 0.0E+00 0.0E+00 0.0E+00 _0.0E+00 0.0E+00 0.0E+00__0.0E+00 _0.0E+00 _0.0E+00

Note that, although it is not shown here, these tables extend to the right through 2020.

If you are assessing a program implemented in more than one control area, you will need
to go back and enter program emission rates and displaced emission rates (Steps 5 and 6)
for the other control areas on the “ Displacement Calcs’ sheet. To do this, use Boxes4
and 5 for New York and Boxes 7 and 8 for New England.

After you have donethis, total emission reductions for each control area (summed across
al time periods) will appear in Tables 10, 11 and 12, at cell BUS. These Tableswill aso
appear in Box 2 of the “Inputs& Results’ sheet at cell B41. (Box 1 shows key inputs, and
Box 2 shows key results)) Figure 2.18 showsthese Boxes. In addition, thereis a space
for notes at the bottom of Box 2. Record other important inputs and assumptions here.
Note that you must round your results to two significant figures a some point before you
present them, because the default emission ratesin the Workbook only contain two
ggnificant figures. In most calculations, the Workbook will present results with far too
many sgnificant figures. Save or print Boxes 1 and 2 on this sheet as arecord of your
cdculation.*?

12T save these Boxes electronically, select them, copy them and open anew Excel workbook. In the Edit
menu of the new workbook, select “ Paste Special.” In the dialogue box that appears, select “Values,” and
allow the text pasted to remain selected. Then go to Edit and “Paste Special” again and select “ Formats.”
In the new file, you may have to adjust the “ Zoom” setting (in the View menu) and the column widths for
best viewing. To print thistable, select the table and click “Page Setup” under the File menu. Inthe
dialogue box that appears, select “Portrait” and “Fit-to-One,” and then click “Print.” In the print dialogue
box, click “Selection,” and then “O.K.”
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Figure 2.18: Inputs and Results Box for a Displaced Emissions Calculation (“Inputs &
Results” sheet)

1. Displacement Policies -- Assumptions

[Ealic d- IEnerTex ]

EnterText
ion Rates: EnterText
Load Profile Data: Enter Text
)
2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015
NOx: 0 0 0 0 0 0 0 0 0 0 0 0 0 0
SO2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Coz 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Hg 0 (o] 4] 1] 0 1] ] 1] ] 0 (o] 0 (o] 0
Clean Energy Generation (D/NMWh)
2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015
NOXx: 00 00 00 00 00 00 00 00 00 00 00 00 00 00
S02: 00 00 00 00 00 00 00 00 00 00 00 00 00 00
COo2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Hg: 0.0E+00 ___0.0E+00 _ 0.0E+00 _ 0.0E+00 _ 0.0E+00 _ 0.0E+00 _ 0.0E+00 _0.0E+00 _ 0.0E+00 _ 0.0E+00 _ 0.0E+00 _ 0.0E+00 _ 0.0E+00 __0.0E+00

1.C: Energy Generated/Saved by Policy Assessed (MWhs)

2002 2003 2004 2005 2006 2007, 2008 2009 2010 2011 2012 2013 2014
Ozone Season Weekday 0 0 0 0 0 0 0 0 0 0 0 0 0
Ozone Season Night/Weekend 0 0 0 0 0 0 0 0 0 0 0 0 0
Non-Ozone Season Weekday 0 0 0 0 0 0 0 0 0 0 0 0 0
Non-Ozone Night/Weekend 0 0 0 0 0 0 0 0 0 0 0 0 0
Peak Day 0 0 0 0 0 0 0 0 0 0 0 0 0
Peak Hours 0 0 0 0 0 0 0 0 0 0 0 0 0
[Total | 0 0 0 0 0 0 0 0 0 0 0 0 0

2: Displacement Policies -- Results

**sers should round NOx, SO2 and mercury results to two significant figures and CO2 results to three.***

2.A: PJM Emission Reductions (tons)
2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016

NOx: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
SO2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
COo2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Hg. Q0F+00 _QOFE+00 _QOF+00 _QOF+00 _QOF+00 OQOQF+00 0QOF+00 _QOF+00 QOF+00 _QOF+00 _0O0F+00 _0OF+00 _QOF+00 _QOF+00 __QOQF+00

2.B. _NY ISO Fmission Reductions (tons)

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016
NOx: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
S02: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Coz 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Ha. QOE+00 0 0FE+00 0 O0QFE+00 Q0E+00 Q0E+00 0 0FE+00 Q0400 Q0E+00 0 0FE400 Q0E+00 Q000 0 0FE+00 Q0300 __00FE+00 Q0E+00

2.C 1SO Emission Reductions (tons)

2002 2003 2004 2005 2006 2007, 2008 2009 2010 2011 2012 2013 2014 2015 2016
NOx: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
S02: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Co2 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Hg. QO0F+00 _QOF+00 _QOF+00 _QOF+00 _QOF+00 OQOF+00 0QOF+00 _QOF+00 QO0F+00 0O0F+00 0O0F+00 _0OF+00 QOF+00 _QOF+00 __0QOQF+00

2.D._Total Emission Reductions (fons)

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016
NOx: 0 0 0 [¢] 0 0 0 0 0 0 0 0 0 0 0
S0o2: 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Co2 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Ha: 0.0E+00 0.0E+00 0.0E+00 _ 0.0E+00  0.0E+00 _0.0E+00  0.0E+00 _ 0.0E+00 0.0E+00 0.0E+00 _ 0.0E+00 0.0E+00 _ 0.0E+00  0.0E+00 _ 0.0E+00

Note that, although it is not shown here, these tables extend to the right through 2020.
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3. The Default Data

There are five types of default data stored in the Workbook: default system emisson
rates, data on existing generating unitsin the Northeast, emission factors for various
clean generators, data on eectricity usein the Northeast, and data on the load profiles of
different energy efficiency programs and clean generators. The sources and devel opment
of these different types of default data are described in the subsections below.

3.1 The Default Emission Rates

The workbook includes default displaced rates for seven different time periods within the
year. In other words, we provide, for example, an * 0zone season daytime” displaced rate
for assessment of programs that reduce demand or generate clean energy during those
hours. The default emission rates, shown in Figures 3.1 through 3.3 below, extend from
2002 through 2020, reflecting predicted plant additions and retirements. The seven time
periods for which displaced rates are provided are as follows:

1. Ozone season weekday — the average of dl hourly margina emisson rates during
weekdays, May through September, 7:00 am through 10:59 pm.

2. Ozone season night/weekend — the average of dl hourly margind emission rates
during al nights, May through September, 11:00 pm through 6:59 am, and dll
weekend days during this period.

3. Non-ozone season weekday, the average of dl hourly margina emisson rates
during weekdays October through April, 7:00 am through 10:59 pm.

4. Nonozone season night/weekend, the average of al hourly margind emission
rates during al nights, October through April, 11:00 pm through 6:59 am, and al
weekend days during this period.

5. Annua average — the average emisson rate of dl generating units operating
throughout the year, weighted by the amount of production by unit. (NOTE: this
isthe only average emission rate of the group. The others are marginal emisson
rates.)

6. Peak Day — the average of dl hourly margind emisson rates during the period
7:00 am through 10:59 pm on the day with the highest predicted load of the year.

7. Peak Hours— the average of the hourly margind emisson rates during the 150
highest-load hours of the year, regardless of day or time.

3.1.1 What is an Average Marginal Emission Rate?

The firg thing to note about these default emission rates is that Six of the seven default
rates provided are marginal emisson rates. Assuch, they do not reflect the operation of
mogt of the unitsin the sysslem. Thisis appropriate, because an energy efficiency
program or new renewable generator would only affect the margina unit (or units,
depending on the number of MW displaced). Basdoad units, such as nuclear and
hydrodectric units, will not be affected by reductionsin sysem demand. The “Annud
Average’ rate, however, is an averagerate. Thisdefault rateis provided for usein
asessing EPSs. Because an EPS would regulate retail suppliers portfolio average
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emission rates, one must compare the EPS rate to the system average emission rate to
caculate emisson reductions. Thisis an important distinction regarding the default
emission rates, and users should not use the “ Annual Average’” emission rates to assess
energy efficiency or clean generation programs.

The sx margind emission rates were calculated by . :

comparing total system emissions from a base case The displaced marginal

moddling run and a“ decrement run.” First we Emission ratesare

performed a base case run, smulating plant dispatch “ average marginal”

over the entire Northeast to meet projected hourly loads emission rates.

during the period 2002 through 2010. (Notethat all

modding runs included (Hydro Quebec, the Maritime They are the average of

Qreaand Ontario.) '?l]@cﬁ,l\éva%pfef Ofmsg Tédeeby all the hourly marginal
ecrement runs, in whi s were redu two : .

percent in each of the three control areas, PIM, NY 1SO eml.$| on rates during the

and ISO NE. To caculate displaced emission rates for period.

PIM, we compared total emissonsin the base case run

and the decrement run in which loads were reduced in PIM. To assess the 0zone season
daytime period, we subtracted total emissions during these hoursin the decrement run
from total emissionsin the base case run and divided the difference by the total MWhs
“saved.” (MWhs saved is smply the difference in MWh production in the two runs.)

Thus, the displaced margina emission rates can be viewed as * average margind”

emisson rates. They are the average of dl the hourly margind emission rates during the
period. Importantly, when assessing base case and decrement case emissions, we
factored in emissonsin all control areas simulated, not just the control areain which we
reduced loads. Thisisimportant, because load reductions (or additiona generation) in
one control area affects the operation of generating units in neighboring control aress,

and changesin emissons in those areas are just as important as changes in the target
control area. Thus, the default emission rates for New England, for example, reflect
predicted changesin emissonsin al control areas resulting from load reductionsin New
England.

3.1.2 Selecting the Right Default Emission Rate

Sdecting theright default emisson rate for the program you are ngiscrucid. An
important point hereis that the first four default rates (numbered 1 through 4 above) can
be used together, while the fina three should be used independently, to describe entire
programs. In other words, users can spread the energy saved by an efficiency program
across one, two or dl four of the ozone/non ozone, day/night periods. Together, these
four periods encompass dl 8,760 hoursin ayear. For example, auser might take a

basd oad type energy efficiency program, and alocate the projected savings across the
firgt four time periods. (Other default data has been included in the Workbook to help in
thisdlocation — see Section 2.3 above.) In contrast, the “Peak Day” and “Peak Hours’
emission rates shoud be used to describe an entire program that operates only during one
of those periods. Users should not alocate program energy across, for example, the
“Ozone Season Daytime” period and the “Peak Hours’ period. The “Peak Hours’ period
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is asubset of the “ Ozone Season Daytime” period; Thefirst four default
designed to assess more accurately programs that rates can be used

operate only during the peak hours of the year. together. Energy froma
As discussed above, the “ Annua Average’ rate should program can be allocated

be used by itsdlf to assess EPSs. Programs that displace across these time periods.
generation from the grid should not be assessed using

this defaullt rate. The other threerates

In Table 3.1 below, we indicate which defauil retes should be used

should be used for selected program types. As noted, ' ndep_endent_l y, to

on the “ Program Pen” sheet of the Workbook, thereis describe entire programs.

more detailed information to help users alocate energy

across time periods.

Table 3.1: Choosing the Right Displaced Emission Rates

Energy Program Best Displaced Emission Rate
M ust-Run Renewables (e.g. wind, solar) Allocate energy across first four default rates.
Dispatchable Generators (e.g. biomass) Allocate energy across first four default rates.
Residential Refrigerators Subsidy Allocate energy across first four default rates.
Residential Air Conditioner Subsidy Allocate energy across first four default rates.
L oad Management Programs “Peak Hours” Rate
Emission Performance Standard “Annual Average” Rate

3.1.3 How the Default Rates Were Developed

As discussed dsawhere in this manud, the default displaced emisson rates within the
OTC Workbook are divided into three time periods. 2002-2005; 2006-2010 and 2011-
2020. (Throughout this paper these time periods are cdled the near term, medium term
and long term, respective %/.) The default rates for each of these periods were developed
using different techniques™™

The near-term rates are based entirdly on PROSY M modedling runs. We rely entirely on
the moded for the near term andys's, because we know the generating units that will
condtitute each regiona power system in the near term with ardaively high levd of
certanty. PROSYM smulates system operation on an hourly basis, dispatching
generating units each hour to meet load. The smulation is based on unit-specific
information on the generating units in each of the three Northeast regions (informeation
such as unit type and size, fud type, hest rate curve, emisson and outage rates and
operding limitations). The smulation is done in chronological order, so actud
condraints on system operation (such as unit ramp times and minimum up and down
times) are taken into account.

In predicting emission reductions over the medium term and the long term, plant
additions and retirements will play asignificant role. Thisis because over the medium

13 Note that users are not required to use the default displaced emission rates when eval uating programs;
users may enter their own displaced emission rates.
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term, decisions made by power plant owners and new plant developers will take into
account changes in the regiona power system that took place during the near term. For
example, demand forecasts made in 2006 will take into account conservation and load
management programs implemented in the near term as well as new clean generators
instdlled in this period. Similarly, demand forecasts made in 2011 will take into account
programs implemented in the near term and the medium term. Some planned units will

be deferred if energy efficiency has dowed load growth and new renewables have come

on line, and some older plants may be retired earlier. Therefore, at first, energy efficiency
and new renewables displace energy from existing resources, but over time, they displace
energy from a mix of existing resources and potential new resources — and they affect
plant retirement decisions. The different techniques we use to derive displaced emisson
ratesin these three time periods reflect thisfact. These techniques are described in the

two subsections that follow.

3.1.4 The Near-Term Displaced Rates (2002-2005)

The near-term displaced rates are derived from PROSY M andyses of system dispatch
over the near term. To derive these emisson rates, we first performed a “base case”
modd run, smulating plant digpatch across dl three control aress for each year. We next
performed three “ decrement” mode runs. In one decrement run, al hourly loadsin PIM
were reduced by one percent; loadsin ISO New England and NY SO were not reduced.
In another decrement run, loads in SO NE were reduced by one percent, and in the third,
NY SO loads were reduced. To caculate margina emission rates for different periods,
we cdculated the totd difference in kWhs generated between the base case and
decrement case and the total differencein emissons. We then divided emissons by

kWhs to derive the margind emission rate for the time period.

Note that, when assessing load reductionsin a given control area, we have andyzed
changes in emissions across six interconnected control areas. PIM, New York 1SO, SO
New England, Maritimes, Ontario and Quebec. Thus, the six sets of margind rates take
into account changesin generation in al these areas resulting from the load reductionsiin
the target control area. In contrast, the system average rates only include emissions a
generators in the target control area.

For the period 2002 through 2005, we add specific new generating units into PROSY M
based on our andysis of power projects proposed and under construction in these three
control areas. Weretire old generating facilities based on aamilar andyss of planned
retirements. Unit additions and retirements for this period are shown in Appendix A of
this document. These assumptions about unit additions and retirements have an
important impact on the leve of the digplaced emission rates over thisperiod. (This
impact is discussed further in Section 3.1.3 below.) For the medium term and the long
term, we do not attempt to predict the specific units that will be added and retired. We
rely on ageneral assumption about unit additions and retirements.
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Figure 3.1: The Default Displaced Emission Rates for PJM (Ib/MWh)

1: PJM Default Data

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015
1A: PIM Ozone Season Weekday (Ib/MWh)
NOXx: 22 1.9 18 18 17 16 14 12 10 0.8 0.8 0.8 0.8 0.8
S02: 31 3.0 30 34 25 28 26 21 19 0.9 0.9 0.9 0.9 0.9
Cco2: 1,300 1,260 1,210 1,230 1,140 1,160 1,160 1,130 1,130 1,030 1,030 1,030 1,030 1,030
Hg. 25E-05 23F-05 26F-05 30F-05 20F-Q05 30F-08 28F-05 25F-05 24F-05 2A4F-05 24F-08 24F-08 24F-05 1 0F+00
1.B: PIM Ozone Season Night/Weekend (Ib/MWh)
NOXx: 35 18 18 17 14 12 11 10 0.9 0.8 0.8 0.8 0.8 0.8
SO2: 10.5 9.5 7.6 59 30 29 28 27 2.8 0.9 0.9 0.9 0.9 0.9
Cco2: 1,690 1,610 1,480 1,380 1,180 1,160 1,150 1,140 1,150 1,030 1,030 1,030 1,030 1,030
Hg: 10F-04 96F-05 B82F-05 G6BF-05 39F-05 35F-05 34F-05 28F-05 26F-05 24F-05 24F-05 2A4AF-08 24F-05 2 A4F-05
1.C: PIM Non-Ozone Season Weekday (Ib/MWh)
NOx: 21 18 15 13 12 1.0 1.0 10 0.9 0.8 0.8 0.8 0.8 0.8
SO2: 34 28 21 18 11 11 11 11 10 0.9 0.9 0.9 0.9 0.9
Co2: 1,420 1,310 1,220 1,160 1,060 1,070 1,080 1,090 1,090 1,030 1,030 1,030 1,030 1,030
Hg 18F-05 15F-05 13F-05 11F-05 15F-05 16F-05 28F.05 20F-05 22F-05 24F.05 24F-05 24F.05 24F.05 2 A4F.05
1.D: PIM Non-Ozone Season Night/\Weekend (Ib/MWh)
NOXx: 33 32 29 28 18 15 12 11 0.9 0.8 0.8 0.8 0.8 0.8
SO2: 89 9.0 85 8.0 43 39 33 29 26 0.9 09 0.9 0.9 0.9
Cco2: 1,680 1,630 1,550 1,510 1,250 1,230 1,190 1,170 1,170 1,030 1,030 1,030 1,030 1,030
Hg: 85F-05 83F-05 78F-05 75F-05 48F-05 4QF-05 209F-05 28F-05 26F-05 24F-05 24F-05 24F-05 24F-05 24F-05
1.E: PIM Annual Average (Ib/MWh)
NOXx: 23 23 21 21 21 21 21 21 21 21 21 21 21 21
SO2: 8.0 8.0 75 71 71 71 71 71 72 7.2 71 71 71 71
Cco2: 1,180 1,180 1,150 1,130 1,140 1,140 1,150 1,150 1,170 1,170 1,170 1,170 1,170 1,170
Hg. 80E-05 79E-05 77E-05 74E-05 73E-05 73E-05 73E-05 73E-05 74E-05 74E-05 7A4E-05 74E-050 74E-05 74E-Q5
1 E- PIM Peak Day (Ih/MWh)
NOXx: 4.0 44 47 46 35 33 3.0 27 26 25 25 25 25 25
SO2: 22 18 13 18 20 20 18 17 17 16 16 16 16 16
Co2: 1,500 1,370 1,230 1,240 1,370 1,450 1,450 1,490 1,480 1,490 1,490 1,490 1,490 1,490
Hg. QOF+00 0 O0F+00 00F+00 00F+00 00F+00 0O0F+00 0Q0F+00 QO0F+00 00F+00 00F+00 00F+00 00F+00 00F+00 0Q0F+00
1.G: PIM Peak Hours (Ih/MWh)
NOXx: 32 35 38 40 33 3.0 29 28 26 25 25 25 25 25
SO2: 17 16 16 15 16 1.7 16 16 16 16 16 16 16 16
CO2: 1,430 1,380 1,320 1,330 1,410 1,460 1,480 1,480 1,480 1,490 1,490 1,490 1,490 1,490
Hg. QOE+00 QOFE+00 0O0OF+00 00FE+00 00E+00 0O0E+00 QO0FE+00 QOE+00 QOE+00 0QO0F+00 00QFE+00 00FE+00 0O0E+00 0Q0FE+00

The default rates for the period 2016 through 2020 are the same as those in 2015.
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Figure 3.2: The Default Displaced Emission Rates for New York ISO (Ib/MWh)

2: NY ISO Default Data

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015
2 A- NY ISO Ozone Season Weekday (Ib/MWh)
NOXx: 2.1 2.0 1.8 1.7 1.1 0.9 0.9 0.8 0.7 0.6 0.6 0.6 0.6 0.6
SO2: 5.4 4.7 3.7 3.2 2.0 2.3 2.5 2.2 1.8 0.6 0.6 0.6 0.6 0.6
Co2: 1,370 1,370 1,330 1,280 1,110 1,120 1,130 1,130 1,120 970 970 970 970 970
Hg: 38E-05 32F-05 26FE-05 24F-05 26FE-05 29F-05 28F-05 25FE-05 24FE-05 24FE-05 24FE-05 2 4FE-05 24FE-05 2 4F-05
2.8 NYISO Ozone Season Night/\Weekend (Ib/MWh)
NOXx: 2.8 2.5 2.0 1.7 1.1 0.9 0.7 0.7 0.6 0.6 0.6 0.6 0.6 0.6
SO2: 9.5 8.1 6.4 5.4 2.9 2.6 2.3 2.2 2.3 0.6 0.6 0.6 0.6 0.6
Co2: 1,670 1,560 1,450 1,390 1,160 1,110 1,060 1,050 1,060 970 970 970 970 970
Ha: 8.8E-05 8.0E-05 6.8E-05 6.0E-05 4.1E-05 3.4E-05 3.0E-05 2.5E-05 2.5E-05 2.4E-05 2.4E-05 2.4E-05 2.4E-05 2.4E-05
2.C: NY ISO Non-Ozone Season Weekday (Ib/MWh)
NOXx: 2.1 1.7 15 1.4 1.6 0.8 0.8 0.7 0.6 0.6 0.6 0.6 0.6 0.6
SO2: 4.0 3.2 2.9 2.7 1.4 1.3 1.4 1.4 1.3 0.6 0.6 0.6 0.6 0.6
COo2: 1,460 1,380 1,310 1,280 1,100 1,090 1,090 1,110 1,120 970 970 970 970 970
Hg: 21808 1 6FE-08 1 7E-08 20F-05 20F-05 19E-05 2 7E-00 21E-00 22E-00 2A4E-08 2 4E-00 2 4FE-08 2 AFE-08 2 AF-08
2.D: NY ISO Non-Ozone Season Night/Weekend (Ib/MWh)
NOXx: 2.8 2.7 2.6 2.6 1.6 1.3 1.1 0.9 0.7 0.6 0.6 0.6 0.6 0.6
SO2: 8.5 7.9 7.8 8.1 4.2 3.8 3.5 3.3 2.9 0.6 0.6 0.6 0.6 0.6
Co2: 1,610 1,570 1,540 1,540 1,250 1,230 1,220 1,200 1,180 970 970 970 970 970
Hg: ZAFE-Q5 72F-08 71F-05 72F-05 A47F-05 39F-05 29F-05 29F-05 26F-05 24F-08 24F-05 2 4F-05 2 A4F-05 2 AF-05
2. E: NY ISO Annual Average (Ib/MWh)
NOXx: 1.2 1.2 1.1 11 1.1 1.1 1.1 11 1.1 1.1 11 11 11 1.1
SO2: 2.7 2.8 2.6 2.4 2.4 2.4 2.4 2.5 2.5 2.5 2.5 2.5 2.5 2.5
COo2: 810 830 820 800 800 810 820 830 840 840 840 840 840 840
Hg. 28E-05 29F-08 2 7F-05 205F-05 205F-05 205F-05 208F-05 205F-05 26F-05 26F-05 26F-05 26F-05 26F-05 26F-08
2.E: NY ISO Peak Day (Ib/MWh)
NOXx: 3.1 2.8 2.6 3.3 3.2 3.1 3.0 3.0 2.7 2.5 2.5 2.5 2.5 2.5
SO2: 1.5 1.3 1.1 2.0 2.2 2.2 2.0 2.1 1.8 1.6 1.6 1.6 1.6 1.6
COo2: 1,770 1,740 1,710 1,760 1,640 1,620 1,580 1,560 1,530 1,490 1,490 1,490 1,490 1,490
Hg. Q0F+00 QQF+00 00F+00 00FE+00 00FE+00 00F+00 0O0F+00 0O0F+00 0Q0FE+00 00F+00 00F+00 00F+00 00F+00 00F+00
2.G: NY ISO Peak Hours (Ib/MWh)
NOXx: 2.4 2.2 1.9 2.2 2.4 2.4 2.5 2.6 2.5 2.5 2.5 2.5 2.5 2.5
SO02: 0.6 0.5 0.3 0.6 1.3 1.3 1.4 1.6 1.6 1.6 1.6 1.6 1.6 1.6
Co2: 1,590 1,610 1,640 1,660 1,660 1,650 1,540 1,510 1,500 1,490 1,490 1,490 1,490 1,490
Hg: Q0F+00 0Q.0F+00 00FE+00 00E+00 0.0FE+00 0.0F+00 0.0F+00 00F+00 00FE+00 0.0F+00 0.0F+00 0.0F+00 0.0F+00 0.0F+00

The default rates for the period 2016 through 2020 are the same as those in 2015.
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Figure 3.3: The Default Displaced Emission Rates for ISO New England (Ib/MWh)

3: ISO NE Default Data

2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015
3.A:1SQ NF Ozone Season Weekday (Io/MWh)
NOXx: 04 0.4 05 0.7 0.8 0.7 0.7 0.7 0.7 0.7 0.7 0.7 0.7 0.7
SO2: 05 0.7 0.9 13 11 10 038 0.6 04 05 05 05 05 05
CO2: 900 900 920 980 1,030 1,010 980 980 980 1,040 1,040 1,040 1,040 1,040
Hg. 20F-06 30F-06 S0F-06 9O0F-06 18F-05 1OFQ5 20F05 271F-05 22F-05 2A4F-05 2A4F-05 2AF05 24F0Q5 2 4F-Q8
2 R- 18O NE Ozane Seasaon NiahtANeekend (/AW
NOx: 12 11 0.8 0.6 0.6 05 05 0.6 0.7 0.7 0.7 0.7 0.7 0.7
SO2: 38 32 24 16 0.9 0.8 05 05 05 05 05 05 0.5 05
COo2: 1,240 1,180 1,090 1,010 1,000 970 920 920 960 1,040 1,040 1,040 1,040 1,040
Hg- AZE-05 AQF05  20F.05 23F.05 21F.05 18F05 20F.05 21F-05 23F.05 24F.05 24F.05  24F05 24F.05 2 AF.08
2. 1SQ NE Non.Qzane Season \Weekday (h/NMA/R)
NOx: 1.0 0.7 0.4 0.4 0.9 0.6 0.6 0.7 0.7 0.7 0.7 0.7 0.7 0.7
S02: 14 1.0 0.8 0.7 05 04 04 05 04 05 05 05 05 05
CO2: 1,120 1,010 920 890 950 940 940 950 950 1,040 1,040 1,040 1,040 1,040
Hg: 40F-06 A0F-06 40F-06 40F-06 13F-05 15F-05 25F-05 20F-05 22F05 24F-08 24F-05 24F-05 24F-05 24F-05
3.D: 1SO NE Non-Ozone Season Night/MWeekend (Ib/MWh)
NOx: 17 14 11 11 0.9 0.8 0.7 0.7 0.7 0.7 0.7 0.7 0.7 0.7
SO2: 4.0 38 33 30 16 13 11 0.9 0.7 05 05 05 0.5 05
Co2: 1,300 1,220 1,130 1,120 1,070 1,050 1,030 1,010 980 1,040 1,040 1,040 1,040 1,040
Hg: 27E-05 30E-05 27E-05 23F-05 22F-05 21FE-05 16E-05 21FE-05 22F-05 24F-05 24E-05 24F-05 24F-05 2 4F-05
3 E:1SQ NE Annual Average (Ib/MWh)
NOx: 11 11 10 0.9 0.9 0.9 0.9 0.9 0.9 0.9 0.9 0.9 0.9 0.9
SO2: 33 33 29 27 27 27 27 27 27 27 27 27 2.7 27
CO2: 1,000 1,000 960 930 940 940 950 950 950 950 950 950 950 950
Hg: 28F05  28F-05 31F-05 23F05 23F05 24F05 24F-05 24F05 23F-05 23F05 23F-05 23FQ5 23F-05 23F05
3 F: ISO NE Peak Day (Ib/MWh)
NOx: 29 26 23 22 23 24 23 24 25 25 25 25 25 25
SO2: 32 34 36 41 31 29 23 21 1.9 16 16 16 16 16
Co2: 1,800 1,780 1,760 1,820 1,680 1,630 1,520 1,540 1,540 1,490 1,490 1,490 1,490 1,490
Hg. QOE+00 QOE+00 QOQOE+00 0QO0E+00 0O0E+00 O0O0FE+00 QOFE+00 QOE+00 QOE+00 QOE+00 QOQE+00 00E+00 QO0E+00 QOE+00
2.G:1SQ NF Peak Hours (h/MWh)
NOx: 29 24 18 19 22 23 22 23 24 25 25 25 25 25
SO2: 26 35 45 45 31 29 22 19 18 16 16 16 16 16
CO2: 2,050 1,940 1,820 1,830 1,660 1,650 1,540 1,510 1,500 1,490 1,490 1,490 1,490 1,490
Lo Q0F+00  00F+00  00F+00  0O0F+00  00F+00  00F+00  00F+00  00F+00  00F+00  00F+00  00F+00  00F+00  00F+00  00F+00

The default rates for the period 2016 through 2020 are the same as those in 2015.

3.1.5 The Medium-Term and Long-Term Displaced Rates (2006-2020)

Over the medium and long terms, decisions made by power plant owners and new plant
developers will take into account many of the changes in the Northeast dectric industry
that took place during the near term. As noted, demand forecasts made in 2007, for
example, will take into account many of the conservation and load management programs
implemented in the period 2002 through 2005 aswell as new generators ingdled in this
period. To account for this economic dynamic, we have developed medium-term
displaced rates by blending the displaced rates from the exigting system (derived using
PROSY M) with emisson rates representing new generating units and retired units. Our
long-term displaced rates are based entirely on our assumption about unit additions and
retirements.

Predicting plant additions and retirements over the long term is difficult, because it is not
just aquestion of costs. Many factors — regulatory, palitical, economic and financid —
influence the decision to build anew plant or retire an existing one, and plant developers
and owners do not aways behave like the rational market participants assumed in
economics books. Boom and bust cyclesin new plant development have become the rule
in competitive power generation markets not the exception. Some of the factors, other
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than basic economics, that affect decisions about plant additions are the prevailing

attitudes of capitd markets, policies designed to support or discourage certain plant types
and irrationa behavior in the project development process. When it comes to

retirements, key factors in the decison include: the actua operating cost of the unit, the
capacity vaue of the unit (largdy afunction of 1SO-specific rues) and the owner’s
assessment of the hedging value of keeping the plant available. These factors are

discussed in greater detall in Predicting Avoided Emissions from Palicies that Encourage
Energy Efficiency and Clean Power, dso an OTC report.

There are two approaches to predicting plant additions and retirements in a given regiona
electric system over time. One approach is to use an energy forecasting modd that
predicts additions and retirements based on an iterative andlyss of supply, demand and
price feedbacks. Another gpproach is to make predictions informed by close study of the
exiging wholesale market in the region, politica and regulatory dynamicsin the region
and key economic and financid indicators. An advantage to using a forecasting modd is
that, once the input assumptions and agorithms have been set up, the model makes
objective decisions, seeking the optima future solution based on the inputs. This can
lend a sense of credibility to the modd’ s prediction that may be necessary in apolicy-
making setting. An important limitation of forecasting modelsis that their algorithms

may not effectively represent the complex dynamics that affect the decisonsto built new
plants and retire old ones. Regulators and participants in a given regiond energy market
may be able to make an informed prediction that captures these complexities aswell or
better than a computer smulation of that market.**

We have not used aforecasting mode to predict unit additions and retirementsin the
Northeast beyond 2010. Rather, long-term the displaced emisson rates within the
Workbook are based on the following assumptions about unit additions and retirements.
The displaced emisson rates for the Ozone Season Daytime, Ozone Season
Night/Weekend, Non-Ozone Season Daytime and Non-Ozone Season Night/\Weekend
are based on the following assumption:

New units added are assumed to be gas-fired combined-cycle combustion
turbines (CCCTs) with NOy controls (SCR). These units are assumed to
have heat rates of 7,000 Btu per kwh and NO, emisson rates of 0.06
Ib/MWHh. SO, emissions are assumed to be zero.

Old unitsretired are oil- or oil/gas-fired steam units built before 1960.
Emission rates are assumed to be: 2.4 Ib/MWh NOy and 1.8 Il/MWh SO..
These rates are the average of dl the pre-1960 oil and oil/gas steam units

in ISO New England, New Y ork 1SO and PIM.

Capacity added is assumed to be greater than capacity retired by aratio of
31

Thelong-term (2011 — 2020) displaced emission rates for the Pesk Day and Peak Hours
periods are based on the following assumption:

14 These two approaches to forecasting are also discussed further in the report, Predicting Avoided
Emissions from Policies that Encourage Energy Efficiency and Clean Power.
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New units added are assumed to be a 50/50 mix of gas- and ail-fired
ample-cycle pesking turbines with NOy controls (SCR). These unitsare
assumed to have hest rates of 9,700 Btu per kWh and NOy emission rates
of 0.1 pounds per MWh. SO rates are assumed to be zero (gas-fired) and
2.9 Ib/IMWh (oil-fired).

Old unitsretired are assumed to be a 50/50 mix of gas- and oil-fired
ample-cycle pesking turbines without emission controls. These unitsare
assumed to have heat rates of 14,400 Btu per kWh, representative of many
older combustion turbines in the Northeast. NOy emission rates are
assumed to be 9.8 IMWh and SO;.rates are zero Ib/MWh (gas-fired) and
4.2 Ib/IMWh (oil-fired).

Capacity added is assumed to be greater than capacity retired by aratio of
31

As discussed above, the displaced emission rates in the Workbook for the near term are
derived entirdly from PROSY M modeing runs. For the period 2006 through 2010, we
blend the displaced emission rates developed with PROSY M (for the years 2006 through
2010) with the emission rates of new CCCTs and old steam units. For the long-term
rates, PROSYM andysis was not used; the displaced emission rates consst entirely of a
3:1 blend of new CCCT emisson rates and old oil-gas steam rates.

To make the trangition from the near term rates to the long-term rates, we use a“ straight-
lineweaghting” method. For example, the PROSY M ratesfdl in alinear manner from
being 50 percent of the displaced rates in 2006 to zero percent in 2011 and after. The
new unit and retired unit emission rates together rise linearly from being 50 percent of the
displaced ratesin 2006 to 100 percent of them in 2011 and after. In each year, the
weighting factor for the new unit emission rates is three times that of the factor for retired
units. Table 3.2 shows the weighting factors for each of the three source rates used to
derive the displaced rates for each year of the medium-term period.

Table 3.2: Weighting Factors for PROSYM Marginal Rates and New/Old Plant Rates

20022005 | 2006 | 2007 | 2008 | 2009 | 2010 | 2011- 2020
PROSYM Rales 100 050 | 040 030 020 010 0.00
New CCCT Raies 000 0375 | 045 0525 | 060 0675 075

Old Oil/Ges 000 0125 | 015 0475 | 020 0225 025
Steam Rates

An important aspect of this methodology is that these assumptions are transparent. Users
can clearly see the assumptions about unit additions and retirements on which these
displaced rates are based and can dter these assumptionsiif they chooseto. We believe
this transparency is crucia, because the assumptions about unit additions and retirements
are so important. Users are encouraged to use the Workbook to explore the effects of
different assumptions about unit additions and retirements on long-term displaced
emisson rates.
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3.1.6 More Discussion of the Default Emission Rates

The most important thing to remember about the Sx margind digplaced emisson ratesis
that they represent the average of al the margina emission rates during the indicated
time period. (In contrast, the rateslabeled “ average’ are system average rates, including
al generating units, not just the margina unit.)

Keeping thisfact in mind, note severd important things regarding the displaced emission
rates (shown in Figures 3.1 through 3.3). First, NOy rates are generdly higher during the
night than during the day. In generd, thisis because during the day CCCTsand oil- or
gas-fired seam units are on the margin much of the time, while a night, cod-fired units
with higher NOy rates are on the margin quite abit. To illustrate this point, Figure 3.4
shows how the margind NO rate changes along the supply curve in 1ISO New England.
Thelinein Figure 3.4 isarolling average of the NO rate of each generating unit dong
the 1SO New England supply curve. The generating units have been lined up acrossthe
horizonta axisin order of increesing margina costs, roughly the order in which they are
dispatched to meet loads.®® The point graphed above each generating unit is the average
of the NOy rate of that unit and the four units around it (two on ether Sde) in the supply
curve. By using thisrolling average, we have smoothed the line somewhat but preserved
its generd trends.

Figure 3.4. NO, Emission Rates Along the ISO New England Supply Curve in 2002
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Firgt, look at the shape of the NOy supply curve. Roughly thefirst 7,000 MW in the New
England system is hydro and nuclear baseload capacity. From 7,000 to about 13,000
MW, the region’s fossil-fueled basdload and |oad-following plants dominate — unitswith

15 All the generating units have been “ derated” in Figure 3.4 to reflect the effect of outages. At any given
point in time, some generators will be unavailable due to planned or unplanned maintenance. Thus, the
regional system has less capacity in reality than it does on paper, where all units are assumed to be
available. To shift the supply curveto aposition closer to actual, we list units here at 90 percent of their
reported capacity — a process called derating.
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much higher NO rates. The area between about 13,000 and roughly 21,000 MW is
dominated by relatively new CCCTs (with very low NOy rates) with oil- and gas-fired
steam unitsinterspersed. Above about 21,000 MW lie higher cost oil- and gas-fired
steam units and the region’ s pesking turbines with extremely high NO rates. (The NOx
emisson rates dong the New Y ork and PIM supply curves follow avery smilar shape,
except that the rates tend to be higher in New Y ork and higher till in PIM. Figures 3.6
through 3.8 below compare the NOk and SO, curvesfor each of these three control
areas) Looking at Figure 3.4, we can see why margind emission rates are different
during different periods of the day and year — because loads fall in different areas of the
supply curve during these periods.

To darify this point, Figure 3.5 shows the same graph of 2002 NO ratesin 1ISO New
England with curves added showing the distribution of loads. Here, the curves marked
by triangles and squares are histograms showing the distribution of predicted hourly load
levelsin New England during the ozone season weekday period (triangles) and the ozone
Season night/weekend period (squares). The higher the curve is above the horizonta
axis, the more hours during the period that the regiond load was at that level. For
example, the top of the weekday (triangle) histogram indicates that the pesk hourly load
is expected to be roughly 15,500 MW for about 195 ozone season weekday hoursin
2002. (The number of hours associated with each histogram point is shown on the right-
hand verticd axis) Thelong “tal” on the right Sde of this histogram indicates that |oads
are expected to reach very high levels during ozone season weekdays in New England,
but they are expected to do so for avery smal number of hours.

Because generating unit capacities have been derated to develop Figure 3.5 and loads
have been projected from 2001 |oads, this should not be treated as a highly precise
representation of these interactions. However, the level of precison is more than

adequate to support the key points being illustrated: that daytime loadstend to fdl ina
“lower-NOy” region of the supply curvein New England and night/weekend loads, in a
“higher-NOy” region. The same patterns can be seen in the default displaced emission
rates (shown in Figure 3.3), because they are based on the same data sets. The margina
NOxy rate for the ozone season is 0.4 Ib/MWHh, and the rate for the night/weekend period is
1.2 Ib/MWh. The margind NO rate for the “Peak Day” and “Peak Hours’ periods are
higher ill, both at about 2.9 Ib/MWh.
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Figure 3.5: 1ISO New England NO, Curves and Distribution of Loads
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The policy implications of Figure 3.5 are Sgnificant. If the god isto use energy
efficiency programs, for example, to reduce NOy emissons, then programs should be
selected that reduce demand during the lowest load hours of the night/weekend period
and the highest load hours of the daytime period.

Figures 3.6 through 3.8 compare the NOy and SO-, curves for PIM, NY 1SO and ISO NE.
Note that the emissons curves for the different control areas are different in some ways

but dl follow the same basic shape. The NOk emission rates dong the New Y ork supply
curve are higher than thosein New England, and those in PIM are higher till. Also, PIM
has amuch larger region of basdoad foss| units — with higher NOy and SO, rates than do
New York and New England. These graphs were constructed in the same way as Figure
3.4 using data on the generating units in the other two control aress.
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Figure 3.6: Comparison of PJM NO, and SO, Emission Rates
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Figure 3.7: Comparison of New York NO, and SO, Emission Rates
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Figure 3.8: Comparison of New England NO, and SO, Emission Rates
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Returning to Figures 3.1 through 3.3, note dso that in al control areas, NOx ratesfdl
rather quickly from their 2002 levels by the year 2005. This dynamic reflects the
implementation of the federa NOy SIP Cdll rulein 2003. We assume that plants affected
by the SIP Cdl rule comply in the year 2003, achieving an emission rate equa to roughly
0.15 Ib/mmBtu during the summer ozone season. System average ratesin New Y ork and
PIM stay near the SIP Call rates for most of the rest of the period. No other future
environmental regulations are reflected in the displaced emisson rates.

In addition, note that the displaced rates for both NOy and SO, fdl over the study period
to levels that are quite Smilar across al three control areasin the period 2011 through
2020. Thisisaresult of our trangtion from current actud rates (predicted by PROSY M)
in the near term to long-term rates, which are based entirely on the assumption discussed
above about plant additions and retirements. (The long-term assumption is the same for
al three control aress).

In the near term and the medium term, the displaced rates change from year to year due to
the interaction of two factors: load growth and plant additions and retirements. As
electricity loads grow over time, if there were no new plants added, margind NOy and
CO, rates would rise, as peaking turbines were operated more (and, of course, ultimately
the system would fail to meet the load). So growing loads tend to exert an upward
influence on margind emissons over time. Thisinfluence is most pronounced on NO

and CO, emissions, because peeking turbines have much higher NOy and CO», rates than
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the fossI-fueled steam units just below them in the dispatch order. In contrast, plant
additions and retirements exert a downward influence on margind emisson rates over
time, as older, dirty units are replaced by new, cleaner ones. Theinteraction of these two
dynamics causes margina emisson rates to move up and down year to year on a
generdly downward doping trgectory.

To visuaize the interaction between plant additions and load growth, return to Figure 3.5
above. Asnew plants are added — primarily CCCTs— envison the supply curve growing
primarily by sretching in the low-NOy “valey” in the middle of the curve. Load growth
on this graph would appear as adow, steady movement to the right of both load
histograms. During aburst of capacity expansion, the low-NOy “vdley” in the middle of
the curve would expand much faster than load growth, and much more of the daytime
(triangle) load curve would fal in thet valley. The daytime margina NOy rate would fall.
Over time, asloads caught up to capacity expansion, more and more of the daytime hours
would fdl in the higher NOy region of the curve, and the daytime margind NO rate
would rise again.

In fact, al three northeastern control areas are currently experiencing capacity expansion
“booms,” which will expand capacity margins. During the period 1999 through 2004
large amounts of new CCCT capacity are coming on line in each region. After about
2004, this building activity is expected to dow, and capacity margins to begin shrinking
agan.

3.2 Default Data on Existing Generating Units

In order to assess emission reductions from future multi- pollutant regulations users need
information about the current emission rates and utilization of fossI-fueled plantsin the
region. We provide information on 178 fossil-fueled generating unitsin the OTR (see the
“Multi-P Data” sheet). For each unit, we provide projected SO, NOy, CO, and mercury
emisson rates for the years 2002 through 2020. The SO,, NOy and CO, rates are taken
from EPA’s Acid Rain database, 2000. The year 2000 NOy rates from EPA’ s database
are used for the 2002 rates on the “Multi-P Data’ sheet. 1n 2003, the NOy rates of dl
units go down to reflect compliance with the NOy SIP Cdll rule. (None of the other
emission rates reflect future regulations.) To represent seasond compliance with the SIP
Cadl, the following equation was used to calculate the post SIP Cal NOx rate for each
unit:

(Base Rate * 7/12) + (0.15 Ib/mmBtu * 5/12)
Here, the “base rate’ isthe NO rate from the 2000 Acid Rain Database.

These default emission rates d o reflect the implementation of Massachusetts and New
Hampshire regulations affecting certain existing fossl-fueled boilers. The Massachusetts
regulation isat 310 CMR 7.29, and the New Hampshire regulation is the “ Clean Power
Act,” (House Bill 284) passed in 2002. Aswith the SIP Cdl, we have shown the
“compliance emisson rat€’ in the default data, regardless of whether complianceis
expected via arate reduction or via allowance or offset purchases.
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The mercury emission rates for the cod-fired unitsin the default data have been replaced
with rates devel oped using the 1999 stack tests performed for EPA’s Information
Collection Request (ICR). The new mercury rates are based on actua stack test data
from the generating unit where stack test data are available. For units at which stack tests
were not performed (most of the units on the list), we have used proxy emisson rates
developed from the ICR stack tests. To develop proxies, wefirst calculated the average
results of the stack tests performed for each * coal-boiler-control” category established by
EPA. Post-control emission rates in I/mmBtu were taken from the actua stack test
reports submitted by companiesto EPA as part of the ICR. Next we placed the
generating units on the multi- P default list (at which stack tests were not performed) into
the same coal- bailer-control categories asthose used inthe ICR. Findly, we applied the
gppropriate category average mercury emission rate from the ICR to each unit.

For nineteen of the units on the new “Multi-P Data” shest, stack test data have not been
published and there is no corresponding codl- boiler-control category from the 1999 ICR
dack tests. (In otherswords, EPA did not test any units exactly like the unit on the multi-
Plis.) Datafrom unitsor cod-bailer-control categoriesjudged to be smilar were used
for these units.

For dl pollutants, the Ib/mmBtu emisson rates from the Acid Rain Database or ICR
stack tests were converted to output-based rates (Ib/MWh) using unit-specific hest rates.
These hegt rates are shown in column DV of the new “Multi-P Data’ worksheet.

We ds0 provide capacity factors (utilization rates) for the units on the “Multi-P Data’
sheet. These capacity factors are for the years 2002 through 2020. The factors for 2002
through 2010 are taken from the outputs of the base case PROSY M run used in
caculating default emission factors. The capacity factors for the period 2011 through
2020 are reduced from the 2010 factor by two percent pear year.

3.3 Dataon Clean Generators

Users assessing policies that incentivize new clean generaion will need to make an
assumption about wheat type of new clean units will result from the policy. For example,
auser assessing an RPS will need to cdculate awelghted average emission factor for the
renewable generation meeting the RPS. To help users do this, we provide a table with
default emission rates from clean generators (Table 2 on the “ Program Rates’ sheet).

The emisson rates for landfill gasin this table are zero, based on the assumption that
landfills large enough to contemplate electricity generation are currently required to
capture and flare waste gases. So the basdline emission rates from these facilities are
those of landfill gas burned in an open flare, and eectricity generation is assumed to have
no net emissions. More research is needed to test the vaidity of these assumptions and to
compare the actua emissions from landfill gas generators with open flares.

Fud cell emission rates are taken from literature from ONSI Corporation on emissons
from the PC-25, a phosphoric acid fud cdl with an externa fuel reformer. Microturbine
emissons are based on information from Capstone Corporation about the Capstone C60
microturbine (operating on naturd gas).
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Emissions from exigting biomass units assume combusgtion in atraditiona steam boiler

(not fluidized bed or gasified biomass) with NOy controls. Unit hegt rate is assumed to

be 10,000 BtwkWh. The biomass fuel is assumed to be grown in a carbon-neutrd cycle,
asisrequired by most RPSs. NOy and SO, emissons from existing biomass are from
Powering the Midwest, Renewable Electricity for the Economy and the Environment, a
1993 report of the Union of Concerned Scientists, and U.S. EPA’s, AP-42 Compilation of
Air Pollutant Emission Factors, Volume 1, 1996. We provide arow in Table 3 for the
users of the Workbook to enter biomass emission limits specific to aparticular RPS. The
user can either assumethat al biomassin the RPS meets the standard or only new

biomass, usng the rows for “exigting” and “new” biomassin Table 3.

3.4 Dataon Future Electricity Use

Datain future dectricity use (2002 through 2020) is provided on the “Electricity Usg’
sheet for the evaluation of EPSs. The 2002 data is based on year 2000 dectricity saes
data from the U.S. Energy Information Adminigiration (EIA). We have increased year
2000 dectricity sdles by 1.5 percent each year to derive energy use numbers for the 2002
— 2020 period. We adso provide a Table (Table 2 on the “Electricity Use” sheet inwhich
users can calculate future energy use using their own assumption about load growth.

3.5 Program and Technology Load Shapes

Default load profiles are provided for basdload generators and wind and solar generators.
These profiles dlocate the generation from these resource typesinto the firgt four time
periods (shown in Figures 3.1, 3.2 and 3.3) for assessment with the default emisson
factors. The Workbook aso includes load profilesfor 16 energy efficiency program

types.

The default load profile data for wind generation is based on actua generation data from
awindfarm in Chandler, Minnesota. Idedlly, this Workbook should have wind load
profile based on afacility in the Northeast, however publicly available datafrom a
Northeast Site could not be found. There may not be alarge difference in the distribution
of wind energy across seasons between Minnesota and the Northeast, and this would
make the Chandler data afairly good approximation of the distribution of the Northeast
wind resource. Future work on the Workbook could explore this question and continue
to seek a st of hourly data from a Northeast wind site.

The default load profile data for solar generation was developed by Synapse Energy
Economics usng “typicad meteorologica year” insolation data from alocation near the
center of the Northeast. Typica meteorologicd year dataare publicly available from the
PV program at Sandia Nationa Laboratory.

The default load profiles for energy efficiency programs are based on proprietary hourly
data sets for each of the 18 technologies that have tables on the * Program Pen” sheet.
Synapse Energy Economics reviewed these data sets and devel oped the tables on the
“Program Pen” sheet. These are the only datain the Workbook that are not publicly
avalable. The default load profiles for energy efficiency programs are shown in Table
3.3, below.
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Table 3.3: Default Load Shapes for Energy Efficiency

Ozone Ozone Non- Non-Ozone
Target End Use Day Night/ Ozone Night/
Weekend Day Weekend
Residential Appliances
Energy Star Refrigerator 21% 22% 28% 29%
Energy Star Dishwasher 20% 22% 28% 31%
Energy Star Clotheswasher 24% 13% 42% 21%
Energy Star Residential Air Conditioner 65% 35% 0% 0%
Continuous Running Equip. 19% 21% 30% 29%
Residential Lighting
Compact Fluorescents 22% 15% 37% 26%
RC Fluorescent Fixture 22% 15% 37% 26%
Torchiere 22% 15% 37% 26%
Fixtures Other 22% 15% 37% 26%
Commercial
Commercial Lighting — New 26% 16% 36% 22%
Commercial Chillers — New and Retrofit 45% 39% 7% 9%
Commercial Large Motors — New and Retrofit 25% 16% 36% 23%
Commercial VSDs — New and Retrofit 22% 10% 47% 21%
Commercial Comprehensive New Construction
Design 24% 19% 25% 32%
Industrial
Industrial Lighting — New and Retrofit 26% 16% 36% 22%
Industrial Unitary HVAC 45% 39% 7% 9%
Industrial Chillers — New and Retrofit 45% 39% 7% 9%
Industrial Motors — New and Retrofit 35% 4% 56% 5%
Industrial VSDs — New and Retrofit 35% 1% 56% 5%
C&I Gas Absorption Chiller — New or Replacement 45% 39% 7% 9%

4. Strengths, Limitations and Recommended Work

The OTC Emission Reduction Workbook is intended to facilitate estimation of the
emisson impacts of (1) programs that support energy efficiency and clean generation, (2)
EPSs, and (3) multi- pollutant standards applied to existing eectric generating units. The
workbook is designed to be trangparent, meaning al input assumptions associated with a
cadculation are clearly stated.

The default data on displaced emission rates contained within the Workbook were
deveoped using the PROSY M system dispatch software. These emission rates are based
on clearly stated assumptions about the evolution of the three northeastern power pools.
These assumptions are:
Proposds for new generating units through 2005 have been reviewed, and
selected units that appear likely to be completed are assumed to be buiilt.

After 2005, we add new combined- cycle combustion turbines (gas-fired) and
retire older oil- and oil/gas-fired steam units.

We assume that new capacity is added and older capacity retired at aratio of 3:1.
That is, for every 750 MW of new combined-cycle capacity added, 250 MW of
old, steam capacity is retired.

During the period 2002 — 2005, the displaced emission rates are from PROSY M
cdculations. During 2011 — 2020, the displaced emission rates are the weighted
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average of unit additions and retirement. During 2006 — 2010, the displaced rates
move linearly from the 2005 rates to the 2011 rates.

We bdieve that thisis areasonable forecast of the evolution of the northeastern power
pools. However, we encourage work to test and refine this forecast, to explore other
scenarios and the sengitivities of these systems to different input assumptions. Users are
encouraged to develop their own assumptions about displaced emissions and explore
them with the Workbook.

Specific drengths of this methodology are:

The default rates were developed through system modeling with an hourly,
chronologica digpatch modd induding unit-specific information on generating
units and detailed data on power flows and transmission congtraints within and
between | SOs.

The default emisson rates for programs in one region take into account emission
changesin neighboring regions.
All assumptions on which acaculation is based are clearly defined.

Input assumptions are not “hard wired” into the Workbook; users can change
assumptions to explore other scenarios.

Specific limitations of the Workbook that users should kegp in mind include the

fallowing:
- Predictions of long-term avoided emissions using the Workbook are highly

sengtive to the assumption stated above about unit additions and retirements.

Only one levd of load reduction (2 percent of system load) had been assessed to
develop the displaced emisson factors. Larger or smdler load reductions may
lead to different emissonsimpacts.

The annua operation of efficiency programs and clean generation must befit into
either four annua time periods or one (Peak Day or Peak Hours) period. More
work needs to be done to assess how much this limitation affects projections of
avoided emissons.

L ocation-specific factors within a northeastern region (such as the solar or wind
resource & a given site) are not accounted for.

Ways in which the Workbook could be made more versatile and ussful are as follows:

The Workbook could provide an area where users could alter the default
assumptions about unit additions and retirements to aid them in assessing
different future scenarios. In the current version of the Workbook, users must do
this cdculation themsalves and input the resulting displaced emission rates as
custom data

Research on the probable mix of unit additions and retirements in the Northeast
would be very useful. Thisresearch could take the form of statistica analyses,
discussons with key industry players and scenario exploration with aforecasting
modd.
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More specific load- profile data could be added. For example, the load profile of
wind generation or PV output at specific locationsin the Northeast could be
added as default data.

PROSYM runs using hourly datafor an energy efficiency program or renewable
generators could be performed and compared to the predictions using the four
time periods in the Workbook (or the single peak period) to determine the impact
of these four time periods on results.

If the Workbook iswiddy used, it may be desirable to move it out of Microsoft
Excd into a different software. Some common processes could be automated and
the entire Workbook could be write protected. In its current form, certain sections
of the Workbook cannot be locked for editing.
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Appendix A. Additions and Retirements Assumed in
PROSYM Runs

Unit Additions

Unit Name No Utility Code  |[UnitType OnLine OffLine Trans Area
Athens 1a 3020|CC 08/01/03 08/01/58|NY -F G
Athens 1b 3020|cC 08/01/03 08/01/58|NY-F G
Athens 1c 3020/CC 08/01/03 08/01/58|NY-F G
Bayswater Peaker 1| 1289712916/GT 05/01/02 05/01/57|NY-J K
Bayswater Peaker 2| 1289712916/GT 05/01/02 05/01/57|NY-J K
Bellingham lal 1744092483/CC 03/01/02 01/01/56|NE-SOUTH
Bellingham 1b| 1744092483|CC 03/01/02 01/01/56|NE-SOUTH
Bellingham 1c| 1744092483|CC 03/01/02 01/01/56|NE-SOUTH
Bergen CC 2 3001/cc 06/15/02 01/02/57|PIM-East
Fairless Works Energ 24 610724894/(CC 06/01/04 06/01/59|pJM-East
Fairless Works Energ 2b 610724894/CC 06/01/04 06/01/59 pJM-East
Fairless Works Energ 14 610724894|CC 12/01/03 12/01/58|pJjM-East
Fairless Works Energ 1b 610724894/(CC 12/01/03 12/01/58|pJM-East
Fore River CC la 181598784/CC 04/01/02 01/01/57|NE-SOUTH
Fore River CC 1b 181598784/CC 04/01/02 01/01/57|NE-SOUTH
Fore River CC 1c 181598784(CC 04/01/02 01/01/57|NE-SOUTH
Fore River CC 1d 181598784/CC 04/01/02 01/01/57|NE-SOUTH
Granite Ridge la 103101/CC 05/19/02 01/02/57|NE-NC
Granite Ridge 1b 103101/CC 05/19/02 01/02/57|NE-NC
Granite Ridge 1c 103101(cC 05/19/02 01/02/57|NE-NC
Hay Road CC Exp la 3008|cC 06/01/02 01/02/57|pJM-East
Hay Road CC Exp 1b 3008/CC 06/01/02 01/02/57|pJM-East
Hay Road CC Exp 1c 3008|cC 06/01/02 01/02/57|pIM-East
Hazelton 2 486183406(GT 02/01/02 12/10/56/pJM-West
Hazelton 3|  486183406/GT 02/01/02 12/10/56|pjM-West
Hazelton 4 486183406/GT 02/01/02 12/10/56|pJMv-West
Hunterstown CC 1 1725001269|CC 06/01/03 06/01/58 pPJv-West
Hunterstown CC 2| 1725001269(cC 06/01/03 06/01/58/PIM-West
Hunterstown CC 3| 1725001269(CC 06/01/03 06/01/58|pJM-West
Johnston (RI) lal 1289712916/|CC 11/01/02 01/02/57|NE-SOUTH
Johnston (RI) 1b| 1289712916|CC 11/01/02 01/02/57|NE-SOUTH
Kendall Expansion 1 15811729|CC 06/01/02 01/02/57|NE-SOUTH
Lake Road 2a 3020|CC 04/15/02 04/15/57|\NE-SOUTH
Lake Road 2b 3020(cc 04/15/02 04/15/57|NE-SOUTH
Lake Road 3a 3020|CC 04/15/02 04/15/57|NE-SOUTH
Lake Road 3b 3020|cC 04/15/02 04/15/57|NE-SOUTH
Lake Road la 3020|cC 01/12/02 01/12/57|NE-SOUTH
Lake Road 1b 3020|CC 01/12/02 01/12/57|NE-SOUTH
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Appendix A (continued)
Unit Additions

Unit Name No | Utility Code [UnitTypel  OnLine OffLine Trans Area
Liberty Electric la 107114.CC 02/01/02 01/01/57|PIM-East
Liberty Electric 1b 107114 CC 02/01/02 01/01/57|pIV-East
Linden repower 2a 3001|CC 05/01/03 05/01/58 pJM-East
Linden repower 2b 3001/CC 05/01/03 05/01/58 pJv-East
Linden repower 14 3001/CC 04/01/03 04/01/58 pJV-East
Linden repower 1b 3001|CC 04/01/03 04/01/58 pJM-East
Meridan 1la 3100|CC 06/01/03 06/01/58|NE-SOUTH
Meridan 1b 3100/CC 06/01/03 06/01/58 NE-SOUTH
Milford EPE 14 108137|cC 08/15/02 01/01/56|NE-SOUTH
Milford EPE 1b 108137|CC 03/15/02 01/01/56|NE-SOUTH
Mount Bethel Project 1a 3003|CC 09/01/03 09/01/58 pJiv-West
Mount Bethel Projectt  1b| 3003/cC 09/01/03 09/01/58pIM-West
Mystic CC 1/181598784|CC 04/15/02 01/01/57|NE-SOUTH
Mystic CC 2/181598784|CC 04/15/02 01/01/57|NE-SOUTH
Mystic CC 3/181598784|CC 04/15/02 01/01/57|NE-SOUTH
Mystic CC 4/181598784/CC 04/15/02 01/01/57|NE-SOUTH
n_Atlantic 1/181598784[CC 06/01/02 01/01/57|pIM-East
n_Bethlehem 1 3001|CC 08/01/04 01/01/47|NY-F G
n_Bowline_U3 1 7045(ST 06/01/04 01/01/44\NY-EG
n_Brookhaven 1 3001/CC 01/01/04 01/01/57\NY -CDE
n_Cabot 1 9012|CG 01/01/04 01/02/57|NE-SOUTH
n_Canal 1 7045|CC 01/01/03 01/02/57\NE-SOUTH
n_Chichester 1 3011/CT 06/01/02 01/01/44pIM-West
n_Colora 2 3004|CT 05/01/03 01/01/44 pIvrWest
n_Colora 1 3004/CT 05/01/02 01/01/44 pIMWest
n_Dickerson 1 3006|CT 05/01/04 01/01/44/pJM-West
n_Eagle 1 3009|CT 06/01/02 01/01/44/pJM-East
n_East River 1 9035|CC 09/01/04 01/01/57\NY-J K
n_Eddystone 1 3002|CT 06/01/02 01/01/44,pJM-East
n_Edgar 1/181598784|CC 05/01/02 01/02/57|NE-SOUTH
n_Erie West 1{181598784/CC 06/01/02 01/01/57|pIM-West
n_Heritage 1/181598784/CC 09/01/05 01/01/47\NY -CDE
n_Hosensack 2 3009|CT 01/01/03 01/01/44 pJM-East
n_Hosensack 1 3009/CT 01/01/02 01/01/44 pJv-East
n_Kearny 1 3001/CT 01/01/04 01/01/44 pJV-East
n_Lakewood 1 3009|CT 04/01/03 01/01/44pIM-East
n_Londonberry 1 103101(CG 06/01/02 10/01/57|NE-NC
n_Medway 1/181598784|CT 01/01/04 01/02/57|NE-SOUTH
n_Mickleton 1 3007|CT 06/01/02 01/01/44\pIM-East
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Appendix A (continued)
Unit Additions

Unit Name No Utility Code |UnitType OnLine OffLine Trans Area
n_Orion 1 512079618|CC 01/01/05 01/01/57|NY-J K
n_Passyunck 1 3002|GT 01/01/02 01/01/44pJVv-East
n_Peaker 1 9039/GT 01701704 06/21/56/NY-J K
n_Peaker 2 9039(GT 01/01/04 06/21/56|NY-J K
n_Peaker 3 9039(GT 01/01/04 06/21/56|NY-J K
n_Peaker 4 9039/GT 01/01/04 06/21/56/NyY-J K
n_Peaker 5 9039(GT 01/01/04 06/21/56|NY-J K
n_Peaker 6 9039(GT 01/01/04 06/21/56|NY-J K
n_Peaker 7 9039/GT 01/01/04 06/21/56/NyY-J K
n_Peaker 8 9039(GT 01/01/04 06/21/56|NY-J K
n_Peaker 9 9039(GT 01/01/04 06/21/56|NY-J K
n_Ramapo 1| 1744092483/CC 06/01/04 01/01/47|NY-F G
n_Ravenswood 2| 1285649679|CC 01/01/05 01/01/57|NY-J K
n_Ravenswood 1| 1285649679CC 08701703 01/01/57|NY-J K
n_Sewaren 1 3001|CT 01/01/05 01/01/44pJM-East
n_Smithfield 1 2108060246|CC 01/01/04 01/02/57|NE-SOUTH
n_Susquehanna 1 3003/ CT 01/01/02 01/01/44|pJM-West
n_Towanda 1 3010/CT 06/01/02 01/01/44{pJM-West
n_Towantic 1 229|CcC 06/01/03 01/02/57|NE-SOUTH
n_Wawayanda 1 229|CC 01/01/04 01/01/57|NY-F G
Newington CC 14| 9035|CC 08/01/02 08/01/57|\NE-NC
Newington CC 1b 9035|CC 08/01/02 08/01/57|NE-NC
Ontelaunee la 229|CcC 05/01/02 01/02/57|pJM-West
Ontelaunee 1b 229cCC 05/01/02 01/02/57|pIM-West
PV_NY 1| 1285649679 PV 01701704 12/31/11NY-J K
Red Oak la 103101|CC 03/01/02 01/01/57|pIM-West
Red Oak 1b 103101|CC 03/01/02 01/01/57|pJM-West
Red Oak 1c 103101/CC 03/01/02 01/01/57|pJM-West
Red Oak 1d 103101|CC 03/01/02 01/01/57|pJM-West
SEFCO 1) 2145374275|CG 07/01/02 07/01/57|NY-J K
SEFCO 2| 2145374275|CG 07/01/02 07/01/57|NY-J K
Seward Coal RPW 1 8004|ST 05/01/04 05/01/59 pIM-West
Wallingford 5 3003/GT 02/01/02 08/15/56|NE-SOUTH
Wallingford 3 3003|GT 01/14/02 08/15/56|NE-SOUTH
Wallingford 4 3003/GT 01/14/02 08/15/56|NE-SOUTH
Wallingford 1 3003/GT 01/07/02 08/15/56|NE-SOUTH
Wallingford 2 3003|GT 01/07/02 08/15/56|NE-SOUTH
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Appendix A (continued)
Unit Retirements

Unit Name No Utility Code |UnitType OnLine OffLine Trans Area
Bar Harbor 1-4 9002(IC 01/01/60 01/01/02|NE-MAINE
Essex Dsl 1 9032|IC 01/01/47 01/01/02\NE-NC
CABOT 9 9012|ST 01/01/41 01/01/02|NE-SOUTH
So Norwalk Dsl 1-6 1 9008|IC 01/01/40 01/01/02|NE-SOUTH
Bethlehem Steel NUG IPP| 1980168286|ST 07/01/35 01/01/02|pJM-West
Hay Road Expansion 3 3008|GT 08/30/01 03/15/02|pJM-East
Hay Road Expansion 2 3008|GT 07/30/01 03/15/02|pJM-East
Hay Road Expansion 1 3008(GT 06/30/01 03/15/02|pJM-East
PERC-Orrington 1 9002|ST 01/01/88 12/31/02|NE-MAINE
Sewaren 1 3001[ST 12/01/48 01/01/03 pIM-East
Sewaren 2 3001|ST 11/01/48 01/01/03|pJM-East
Eastport Dsl IC 1-3 9002(IC 01/01/48 01/01/03|NE-MAINE
Linden 1 3001|ST 05/01/57 04/01/03 pIM-East
Linden 3 3001GT 07/01/67 05/01/03|pJM-East
Linden 2 3001|ST 12/01/57 05/01/03|PIM-East
Warren 2| 1725001269|ST 09/01/48 09/01/03|pJM-West
Seward 5 1725001269|ST 04/01/57 10/01/03|pJMvWest
Seward 4/ 1725001269|ST 06/01/50 10/01/03|pJM-West
Caterpillar Tract 1) 1482183565/0T 07/01/89 12/31/03|pJMv-West
Riegel Paper 1 3009|0T 07/01/89 01/01/04{pJM-East
Hunlock 3 3013/ST 09/01/59 01/01/04/pIM-West
Sewaren 3 3001(ST 10/01/49 01/01/04|pJM-East
Waterside 9 9035|ST 10/01/49 01/01/04{NY-J K
Waterside 8 9035|ST 06/01/49 01/01/04|NY-J K
CABOT 6 9012|ST 01/01/49 01/01/04{NE-SOUTH
CABOT 8 9012|ST 01/01/49 01/01/04|NE-SOUTH
Astoria ST 4/ 512079618/ST 03/01/61 01/01/05|NY-J K
Astoria ST 3 512079618|ST 09/01/58 01/01/05|NY-J K
St. Albans 1-2 1 9032|IC 01/01/50 01/01/05|NE-NC
Danskammer 1 1127034565(ST 12/01/51 01/01/06|NY -F G
East River 6 9035|ST 11/01/51 01/01/06|NY-J K
Riverside BG&E 4/ 1312696120/ST 09/01/51 01/01/06|pJM-West
Sewaren 4 3001/ST 07/01/51 01/01/06|pJV-East
Albany 2 3001|ST 12/01/52 01/01/07|NY-F G
Glenwood 4 9038|ST 12/01/52 01/01/07|NY-J K
Howard Down 7 3007|ST 12/01/52 01/01/07|pJV-East
Albany 1 3001|ST 10/01/52 01/01/07|NY-F G
Mason Steam 5 1289712916|ST 01/01/55 12/31/07|NE-MAINE
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Appendix A (continued)
Unit Retirements

Unit Name No Utility Code |UnitType| OnLine OffLine Trans Area
Mason Steam 3| 1289712916|ST 01/01/52 12/31/07|NE-MAINE
Mason Steam 4 1289712916|ST 01/01/52| 12/31/07|NE-MAINE
Far Rockaway 4 9038(ST 12/01/53 01/01/08 NY-J K
Albany 3 3001(ST 10/01/53 01/01/08NY-F G
Delaware 7 313140452|ST 08/01/53] 01/01/08|piM-East
Delaware 8 313140452/ST 04/01/53] 01/01/08/pJM-East
Edge Moor 3 3008|ST 12/01/54) 01/01/09PJM-East
Glenwood 5 9038|ST 11/01/54] 01/01/09NY-J K
Albany 4 3001(ST 10/01/54 01/01/09NY-F G
Danskammer 2 1127034565|ST 09/01/54f 01/01/09|NY-F G
Montville 5 3100/ST 01/01/54| 01/01/09|NE-SOUTH
Rockville Centre 10/ 2022699621/IC 09/01/54 09/01/09 NY-J K
Rockville Centre 9 2022699621|IC 09/01/54| 09/01/09NY-J K
Oyster Creek 1 86743107|NB 12/01/69  12/15/09PJM-East
Astoria ST 5 512079618|ST 05/01/62 01/01/10NY-J K
Burlington MAAC 9 3001|GT 11/01/55 01/01/10pJm-East
Howard Down 8 3007|ST 10/01/55 01/01/10|pIM-East
Cromby 2 313140452|ST 09/01/55 01/01/10pJM-East
East River 7 9035|ST 06/01/55] 01/01/10|NY-J K
Lovett 3 15811729|ST 02/01/55 01/01/10NY-F G
Sayreville 4| 1725001269|ST 04/01/55 04/01/10pJM-East




